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How to use this Competency Based Learning Materials (CBLMs)  

  

The module, Developing Digital Learning Materials contains training materials and 

activities for you to complete. These activities may be completed as part of structured 

classroom activities or you may be required you to work at your own pace. These activities 

will ask you to complete associated learning and practice activities in order to gain 

knowledge and skills you need to achieve the learning outcomes.  

 

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or 

tasks you are going to learn how to do. Once you have finished reading the 

Information Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to 

help you know how you are progressing.  If you are unable to answer the questions 

in the Self-Check you will need to re-read the relevant Information Sheet. Once 

you have completed all the questions check your answers by reading the relevant 

Answer Keys found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step 

by step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practice the job. You may need to 

practice the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be 

provided where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others 

in the training room. Should you require assistance or clarification please consult your 

trainer or facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved 

competency in the specified learning outcomes. You will then be ready to move onto 

the next Unit of Competency or Module  
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MODULE CONTENT 

 

Unit of Competency: Develop Digital Learning Materials 

 

Module Title: Developing Digital Learning Materials  

Module Description: This module discusses the aspects that must be given attention when 

developing digital learning materials. It shows the knowledge and 

skills requirements for arranging learning recourses to be digitized, 

planning for digital learning contents development, collecting media 

elements, preparing digitally formatted contents, testing digitally 

formatted learning resources and uploading & using digital contents. 

Nominal Duration: 30 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Arrange learning recourses to be digitized 

2. Plan for digital learning contents development 

3. Collect media elements 

4. Prepare digitally formatted contents 

5. Test digitally formatted learning contents  

6. Upload and use digital contents 

 

Assessment Criteria: 

1.1 Contents need to be digitized are selected 
1.2 Learning resources specifications are established in line with target learners’ 

requirements 

2.1 Lesson plan is prepared incorporating pedagogy aspect 

2.2 Digital contents to be developed are structured and segmented according to lesson/ 

session plan steps and sequences 

2.3 Types of presentation are planned 

2.4 Content development software and content development tools are selected and 

collected 

2.5 Media elements of the presentation are planned 

2.6 Technology, pedagogy and content knowledge (TPACK) principles are followed during 

the plan of content development 
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3.1. Sources of media elements for the presentation are selected and collected. 

3.2. Media elements are downloaded or collected from appropriate source. 

3.3. Media elements are manipulated and edited as required. 

3.4. Video is cut and appended as required to use in presentation. 

3.5. Open educational resources (OER) are selected and collected  

4.1 Media elements are organized and appended with content development software as per 

lesson/ session plan. 

4.2 Proper action verbs are used and maintained during the preparation of the objectives of 

the session / lesson. 

4.3 Media elements used in digital content are formatted. 

4.4 Appropriate animation is used to make the presentation attractive and interactive 

4.5 OER are accessed and used during the content development process if required 

5.1 Test criteria and instruments are developed in line with learning material specification. 

5.2 Test sites and reviewers are identified in line with established target users 

5.3 Testing of learning contents are undertaken in line with plan 

5.4 Feedback and suggestions are addressed in line with plan and development cycle. 

5.5 Developed digital contents are preserved in appropriate storage 

6.1 Appropriate online media is selected for uploading digital contents 

6.2 Digital content uploading formalities are done 

6.3 Digital contents are uploaded in online media for users  
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Learning Outcome 1: Arrange Learning Recourses to be Digitized  

 

Assessment Criteria:  

1. Contents need to be digitized are selected 

2. Learning resources specifications are established in line with target learners’ 

requirements 

 

Content: 

1. Digital Content 

2. Type of digital content 

▪ Text 

▪ Computer Graphic 

▪ Video 

▪ Audio 

▪ Interactive Multimedia 

3. Learning Resources  

4. Some common types of learning resources 

▪ Textbooks and Reference Books  

▪ E-Learning/ Learning Management Systems (LMS) Platforms 

▪ Educational Web & Mobile Application  

▪ Multimedia Presentations 

▪ Simulation and Virtual Labs  

▪ Open Educational Resources (OER) 

▪ Libraries and Digital Archives 

▪ Collaborative Tools and Online Communities:  

5. Learning resource vs Learning Materials  

6. Learning resources specifications 

7. Learners’ requirements 

 

Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  

 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Blended delivery methods  
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Assessment Methods 

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 1: Arrange Learning Recourses to be Digitized 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Trainee will ask the 

instructor about 

Arranging Learning 

Recourses to be Digitized 

1. Instructor will provide the learning materials 

“Developing Digital Learning Materials” 

2. Read the Information 

sheet/s 

2. Information Sheet No:1 Arrange Learning Recourses to 

be Digitized 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 1 Arrange Learning Recourses to be 

Digitized 

Answer key No. 1 Arrange Learning Recourses to be 

Digitized 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:1- Arrange Learning Recourses to be 

Digitized 

Specification Sheet1 – Arrange Learning Recourses to be 

Digitized 
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Information Sheet 1: Arrange Learning Recourses to be Digitized  

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Select contents need to be digitized  

2. Establish Learning resources specifications in line with target learners’ 

requirements 

 

1. Digital content 

Digital content refers to any type of media or information that is created, distributed, and 

consumed in digital formats. It encloses a wide range of formats, including text, images, 

videos, audio, and interactive multimedia. Digital content can be accessed and transmitted 

through various electronic devices, such as computers, smartphones, tablets, and e-readers. 

 

2. Type of digital content 

There are various types of digital content based on the format and purpose. Here are some 

common types: 

▪ Text: Text is primarily composed of written words and is often 

used for conveying information, expressing opinions, storytelling, 

and providing educational or promotional material. This includes 

articles, blog posts, ebooks, quiz, online news, website content, 

social media posts, and email newsletters.  

▪ Computer Graphic: Computer graphics are visual 

representations captured or created digitally. They can include 

photographs, illustrations, graphics, logos, memes, and infographics. Images are widely 

used for visual storytelling, branding, advertising, and enhancing the visual appeal of 

websites, social media posts, and other digital platforms. 

▪ Video: Video content involves moving visuals and audio. It includes online videos, 

movies, TV shows, documentaries, tutorials, webinars, video blogs (vlogs), and 

advertisements. Videos are a popular medium for entertainment, education, marketing, 

and sharing information due to their ability to engage and captivate viewers. 

▪ Audio: Audio content allows users to listen and consume information while engaged in 

other activities, making it a convenient and portable medium. This type of digital content 

includes sound tracks, podcasts, audiobooks, radio programs and sound effects.  

▪ Interactive Multimedia: Interactive digital content engages users by allowing them to 

actively participate and interact with the content. This can include games, simulations, 

virtual reality (VR) experiences, augmented reality (AR) applications, and interactive 

educational content. Interactive multimedia offers immersive and engaging experiences 

that often blend elements of text, images, videos, and audio. 
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These are just a few examples of the diverse types of digital content available. The digital 

landscape continues to evolve, and new forms of content emerge as technology advances 

and user preferences change. 

 

3. Learning resources 

Learning resources are materials, tools, or platforms that 

are designed/ developed to facilitate and support the 

process of learning. They provide learners with 

information, instruction, and activities to acquire 

knowledge, develop skills, and enhance understanding in 

a particular subject or field. Learning resources can be 

used in various educational settings, including schools, 

universities, online courses, and self-directed learning 

environments. 

 

 

 

 

4. Some common types of learning resources: 

▪ Textbooks and Reference Books: Printed or digital books that provide structured 

information, explanations, and examples related to specific subjects or disciplines. 

Textbooks are commonly used in formal education settings to support curriculum 

objectives. 
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▪ E-Learning/ Learning Management Systems (LMS) Platforms: Web-based platforms 

for delivering educational content, lessons, assessments, and interactive activities. LMSs 

often include features such as course organization, content management, communication 

tools, and assessment capabilities such as ebook, videos, quizzes, H5P, assignment and 

discussion forums. 

▪ Educational Web & Mobile Application: Websites that offer educational content, 

articles, tutorials, videos, and resources on various topics. These sites can provide 

supplemental learning materials, research sources, and interactive tools to support 

learning. Besides mobile applications designed specifically for learning purposes. These 

apps can provide interactive exercises, quizzes, flashcards, language learning tools, and 

educational games. 

▪ Multimedia Presentations: Visual presentations, such as slideshows, videos, and 

animations, that convey information and concepts in a dynamic and engaging manner. 

Multimedia presentations are commonly used in classrooms and online learning 

environments. 

▪ Simulation and Virtual Labs: Interactive software applications that simulate real-world 

scenarios, experiments, or processes and experience. Simulations allow learners to 

experiment, make decisions, and observe outcomes in a controlled virtual environment. 

▪ Open Educational Resources (OER): These are freely accessible learning resources 

available online, including textbooks, lecture notes, multimedia materials, and interactive 

modules. OER promotes open sharing and collaboration in education. 

▪ Libraries and Digital Archives: Libraries and digital repositories offer access to a wide 

range of books, journals, research papers, and other scholarly resources. Digital archives 

provide digitized historical documents, artifacts, and cultural materials for educational 

purposes. 

▪ Collaborative Tools and Online Communities: Platforms that facilitate collaboration, 

discussion, and knowledge-sharing among learners. Online communities, forums, and 

social media groups allow learners to connect, ask questions, and exchange ideas. 

 

5. Learning resource vs Learning Materials  

Learning resources and learning materials are closely related but have slightly different 

meanings. 

Learning Resources Learning Materials 

A broader category of materials, services, 

tools, or platforms 

Subset of learning resources 

Used to facilitate learning Directly used by learners 

Encompasses physical and digital 

materials Can be tangible or digital resources 
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Learning Resources Learning Materials 

Designed to support the learning process Used for hands-on practice, exploration, or 

reference 

Examples include textbooks, online 

courses, educational websites, 

multimedia presentations, simulations, 

etc. 

Examples include worksheets, textbooks, 

workbooks, manipulatives, online quizzes, 

interactive modules, multimedia 

presentations, etc. 

Provide a range of tools and platforms Provide content, activities, and exercises 

Support the learning process as a whole Facilitate acquisition of knowledge or skills 

Can be used by educators to create 

learning environments 

Offer learners opportunities for engagement 

and practice 

 

In summary, learning resources are a broader category of materials and tools that support 

the learning process, while learning materials specifically refer to the resources that 

learners directly interact with for acquiring knowledge or practicing skills. Learning 

materials are a subset of learning resources and provide content, activities, and exercises 

necessary for learning to occur. 

 

6. Learning resources specifications: 

Text, digital images, digital video, web content (including social media), 

data and databases, digital audio and e-book content are all examples of 

learning resources. Whatever the subject, the following components 

should be considered while developing learning resources. 

 

▪ Quality of the presentation: 

The learning resources should be of high quality, with clear and 

concise content, engaging visuals, and appropriate multimedia elements. The 

presentation should be well-structured, easy to navigate, and free of errors. 

 

▪ Format of the lesson plan: 

The lesson plan should be organized in a logical and easy-to-follow format, 

including clear objectives, detailed content, and assessment methods. The format 

should be consistent throughout the learning resources. 

▪ Presentation software to be used: 

The learning resources should be designed to be delivered using a popular and user-

friendly presentation software, such as PowerPoint, Keynote, or Google Slides. The 

software should be compatible with various devices and operating systems. 

▪ Software tools for developing contents: 

The learning resources should be developed using software tools that are appropriate 

for the subject matter and the target audience. For example, for multimedia content, 
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Adobe Creative Suite or video editing software like Final Cut Pro or Premiere Pro 

can be used. 

▪ Type of the presentation: 

The learning resources should be designed to be delivered in a variety of formats, 

such as video lectures, interactive simulations, and quizzes. The type of presentation 

should be appropriate for the subject matter and the target audience. 

▪ Teaching aids for delivery of the lessons: 

The learning resources should include teaching aids such as diagrams, charts, and 

images to support the delivery of the lessons. The aids should be relevant to the 

subject matter and help to reinforce key concepts. 

7. Learners’ requirements: 

When developing digital content, consider diverse learner needs (cultural backgrounds, 

language proficiency, age, and educational levels) by using inclusive language, 

appropriate font sizes, and accessible colors. Accommodate different learning styles 

(VARK) and abilities for maximum comprehension and retention. 

For preparing digital content we need to consider the following points  

▪ Content such as images and videos must have a clear relationship to the topics. 

▪ The content must be relevant to the learner's environment and life 

▪ The content of the picture or video need to be from his / her own country and cultures 

▪ The contents must not be contradictory with the social values, cultures, religion and 

nationally agreed universal political views 

▪ It should be developed considering the age of the learners. 

▪ The content will be such type that it will increase the eagerness of the learner and 

inspire the learners to learn more. 
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Self-Check Sheet 1: Prepare for Validation  

 

1. What exactly constitutes digital content? Provide examples of different types of digital 

content. 

 

 

2. What is learning resources? 

 

 

3. Write the name of some common types of learning resources: 

 

 

4. What are the components should be considered while developing learning resources? 

 

5. What should digital content developers consider when creating content for diverse learners? 

 

 

 

6. Why is it important to use images and videos that are relevant to the learner's environment 

and life? 
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Answer Key 1: Prepare for Validation 

 

1. What exactly constitutes digital content? Provide examples of different types of digital 

content. 

Answer: Digital content refers to any type of media or information that is created, 

distributed, and consumed in digital formats. It encloses a wide range of formats, including 

text, images, videos, audio, and interactive multimedia. Digital content can be accessed and 

transmitted through various electronic devices, such as computers, smartphones, tablets, and 

e-readers. 

There are various types of digital content based on the format and purpose. Here are 

some common types: 

▪ Text  

▪ Computer Graphic 

▪ Video 

▪ Audio  

▪ Interactive Multimedia 

These are just a few examples of the diverse types of digital content available. The digital 

landscape continues to evolve, and new forms of content emerge as technology advances 

and user preferences change. 

 

2. What is learning resources? 

Answer: Learning resources are materials, tools, or platforms that are designed/ developed 

to facilitate and support the process of learning. They provide learners with information, 

instruction, and activities to acquire knowledge, develop skills, and enhance understanding 

in a particular subject or field. Learning resources can be used in various educational 

settings, including schools, universities, online courses, and self-directed learning 

environments. 

 

3. Write the name of some common types of learning resources: 

Answer: Some common types of learning resources are: 

▪ Textbooks and Reference Books 

▪ E-Learning/ Learning Management Systems (LMS) Platforms 

▪ Educational Web & Mobile Application 

▪ Multimedia Presentations 

▪ Simulation and Virtual Labs 

▪ Open Educational Resources (OER) 

▪ Libraries and Digital Archives 

▪ Collaborative Tools and Online Communities 
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4. What are the components should be considered while developing learning resources? 

Answer:  The following components should be considered while developing learning 

resources: 

▪ Quality of the presentation 

▪ Presentation software to be used 

▪ Software tools for developing contents 

▪ Type of the presentation 

▪ Teaching aids for delivery of the lessons 

 

5. What should digital content developers consider when creating content for diverse 

learners? 

Answer: Digital content developers should consider diverse learner needs, such as cultural 

backgrounds, language proficiency, age, and educational levels, by using inclusive 

language, appropriate font sizes, and accessible colors. They should also accommodate 

different learning styles and abilities for maximum comprehension and retention. 

6. Why is it important to use images and videos that are relevant to the learner's 

environment and life? 

Answer: Using images and videos that are relevant to the learner's environment and life can 

help learners connect the content to their own experiences and make it more meaningful and 

engaging. 
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Activity Sheet 1.1: 

 

Activity Sheet 1.0: Identify Learning Resources 

Title: Identify Learning Resources 

Performance Objective: At the end of this task, the trainee should be able to: 

1. Identify and select the learning resources that need to be digitized based on their 

relevance and importance for the target learners. 

2. Justify their selection based on target learners' needs and subject matter importance. 

Policy and Documents Required: 

• Training Need Analysis report 

• Curriculum Outline 

• Course Syllabus 

Tools and Materials Required: 

• List of available learning resources 

• Knowledge of target learners 

• Notebook/Paper for note-taking 

• Pens/Markers 

Equipment: 

• Laptop/Computer 

• Internet connection for research 

Steps/Procedures: 

1. Review the List of Available Learning Resources: 

• Examine the existing list of learning resources that may be considered for 

digitization. These resources could include textbooks, handouts, presentations, 

videos, and other relevant materials. 

2. Refer to the Training Need Analysis Report, Curriculum Outline, and Course 

Syllabus: 

• Study the Training Need Analysis (TNA) report to understand the specific needs and 

preferences of the learners. Analyze the curriculum outline and course syllabus to 

identify key topics and learning objectives. 

3. Determine Relevant and Important Resources: 

• Based on the information from the TNA report, curriculum outline, and course 

syllabus, determine which learning resources are most relevant and important for the 

target learners. Focus on materials that align closely with the learning objectives. 

4. Justify Selections: 

• For each selected resource, provide a justification explaining its relevance to the 

course objectives and learner needs. Highlight how the chosen materials can 

effectively support the learning process and enhance understanding. 

Assessment Method: Submission of a detailed report including the list of identified 

resources and the justification for their selection. The report should demonstrate the trainee's 

ability to critically evaluate learning resources, prioritize based on relevance, and align them 

with the needs of the target learners and the course's subject matter. The report will be 

assessed based on the clarity of the trainee's reasoning and the appropriateness of the selected 

resources for digitization. 
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Specification Sheet 1.1 

 

A. Policy and curriculum documents required 

▪ Bangladesh National Qualifications Framework (BNQF) 

▪ National Skills Development Policy 

▪ National Quality Assurance Document 

▪ Competency Standard Document 

 

B. Tools and Materials required 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

▪ List of available learning resources 

 

C. Equipment 

▪ Laptop/Computer with Internet connection 
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Learning Outcome 2: Plan for digital learning contents 

development 

 

Assessment Criteria:  

 

2.1 Lesson plan is prepared incorporating pedagogy aspect 

2.2 Digital contents to be developed are structured and segmented according to 

lesson/ session plan steps and sequences 

2.3 Types of presentation are planned 

2.4 Content development software and content development tools are selected and 

collected 

2.5 Media elements of the presentation are planned 

2.6 Technology, pedagogy and content knowledge (TPACK) principles are 

followed during the plan of content development 

 

Content:  

 

1. Digital Transformation of Learning Material  

▪  Ideology and Purpose| 

▪  ADDIE Model 

▪  Audience Centric Material Design 

▪  Training Modality 

▪  Universal Design and Accessibility 

▪  Simulations and Real-World Examples 

▪  Impact of Storytelling 

2. Session Plan 

3. Learning Domain 

4. Pedagogy Aspect for Planning Digital Learning Content 

5. Learning Materials Digitalization steps and sequences 

6. Session plan preparing Procedure  

7. Work Plan 

8. Study Guide 

9. Course Blue Print 

10. Instructional design 

11. Courseware: 

12. Structure and segmentation of digital contents 

▪ Clear Organization 

▪ Chunking Information 

▪ Sequential Flow 

▪ Navigation and Signposting 

▪ Visual Hierarchy 

▪ Interactive Elements 

▪ Consistent Design 
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13. Technology, Pedagogy and Content Knowledge (TPACK) principles  

14. Digital Learning Materials/Media Elements 

Types of Media Elements 

▪ Text 

▪ Images (Graphics) 

▪ Videos 

▪ Audio 

▪ Interactive Content 

15. Types of presentation for digital learning production 

16. Digital Learning Production Phase: Preproduction 

▪ Preproduction 

▪ Production 

▪ Post Production 

17. Content Development Software 

▪ Word Processors 

▪ Image Editors 

▪ Video Editors 

▪ Audio Editors 

▪ Screen casting Software 

18. Content Development/Authoring Tools 

Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  

 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Blended delivery methods  

  

Assessment Methods 

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 2: Plan for digital learning contents development 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about planning 

for digital learning 

contents development. 

1. Instructor will provide the learning materials 

“Developing Digital Learning Materials” 

2. Read the Information 

sheet/s 

2. Information Sheet No: 2 Plan for digital learning 

contents development 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 2 Plan for digital learning contents 

development 

Answer key No. 2 Plan for digital learning contents 

development 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:2- Plan for digital learning contents 

development 

Specification Sheet: 2 – Plan for digital learning 

contents development  
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Information Sheet 2: Plan for Digital Learning Contents 

Development 

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Lesson plan is prepared incorporating pedagogy aspect 

2. Digital contents to be developed are structured and segmented according to lesson/ 

session plan steps and sequences 

3. Types of presentation are planned 

4. Content development software and content development tools are selected and 

collected 

5. Media elements of the presentation are planned 

6. Technology, pedagogy and content knowledge (TPACK) principles are followed 

during the plan of content development 

 

1. Digital Transformation of Learning Material 

▪ Ideology and Purpose The initial phase in the digital transformation of learning 

materials involves establishing a clear ideology and purpose. This foundational step 

involves articulating the overarching vision and instructional philosophies that underpin 

the digital learning environment. The purpose is a detailed, well-articulated set of 

objectives and outcomes you aim to achieve with your digital content. 

▪ ADDIE Model: The ADDIE model (Analysis, Design, Development, Implementation, 

Evaluation) is a tried and tested instructional system design (ISD) framework used by 

educators and instructional designers worldwide. It offers a systematic, step-by-step 

roadmap to creating high-quality, effective digital learning materials. 

▪ Audience Centric Material Design: Designing digital learning materials that cater to 

the needs, preferences, and abilities of your target audience enhances the overall learning 

experience. It contributes to personalizing the learning process, which increases content 

relevance and accessibility. 

▪ Training Modality: The choice of training modality, i.e., the mode or method in which 

the learning content is delivered, plays a crucial role in shaping the learning experience. 

Digital learning can occur through various modalities, such as self-paced e-learning 

modules, virtual instructor-led training, webinars, blended learning, and more. The 

chosen modality should align with the learning objectives, learner needs, and logistical 

considerations. 

▪ Universal Design and Accessibility 

Universal Design refers to a broad-spectrum of ideas meant to produce buildings, 

products and environments that are inherently accessible to older people, people without 

disabilities, and people with disabilities. 
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▪ Simulations and Real-World Examples 

Simulations and real-world examples help students apply their learning in practical, 

meaningful ways. They offer safe spaces for learners to practice skills and make mistakes 

without real-world consequences. 

▪ Impact of Storytelling 

Storytelling can significantly impact learning by making content more engaging, 

memorable, and relatable. Through stories, abstract or complex concepts can be made 

more understandable, and learning can be more enjoyable and impactful. 

 

2. Session Plan 

A session plan, also known as a lesson plan, is a detailed outline or guide that outlines the 

structure, objectives, activities, and resources for a specific learning session. It provides a 

roadmap for trainers, instructors, or facilitators to effectively deliver instruction and engage 

learners. 

Session plan serves as a guide for educators to organize their teaching and ensure a 

structured and effective learning experience for their learners. It helps maintain focus, 

provides a clear framework for instruction, and ensures that the session aligns with the 

desired learning outcomes. 

 

3. Learning Domain 

A domain is a particular field of thought, activity, or interest, especially one over which 

someone has control, influence, or rights. 

The three domains of learning are cognitive (knowledge), affective (attitudes), and 

psychomotor (skills). 

This categorization is best explained by the Taxonomy of Learning Domains formulated 

by a group of researchers led by Benjamin Bloom along with in 1956. 

 

Bloom's Taxonomy: 

Bloom's Taxonomy model (1956) is in three parts: 

1. Cognitive domain (intellectual capability, i.e., knowledge, 

or 'think’) 

2. Affective domain (feelings, emotions and behavior, i.e., attitude, 

or 'feel’)  

3. Psychomotor domain (manual and physical skills, i.e., skills, 

or 'do') 

Bloom's Taxonomy was primarily created for academic education; however, it is relevant 

to all types of learning. 

 

  

Benjamin S. Bloom 
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Bloom’s Taxonomy Cognitive domain (2001) 

 

 

 

The cognitive domain contains learning skills predominantly related to mental (thinking) 

processes. According to the newer version (2001) of Bloom’s taxonomy of learning, there are 

six levels of cognitive complexity: remembering, understanding, applying, analysing, 

evaluating and creating.   The six categories under this domain are: 

i) Remembering is the ability to recall data and/or information. Example: A children recites a 

rhythm in different language without understanding anything  

ii) Understanding is the ability to understand the meaning of what is known. Example: a 

student interprets the ohm’s law to his teacher. 

iii) Applying is the ability to utilize an abstraction or to use knowledge in a new situation. 

Example: Calculate current, voltage and resistance what he learned about ohm’s law and 

interpreted to his teacher.  

iv) Analysing is the ability to differentiate facts of the relationship of current, voltage and 

resistance 

v)  Evaluating is the ability to come up with judgments about the importance of concepts and 

integrate different elements or concepts. Examples: Explain the reasoning of variation of 

values of the electrical quantities in different situation 

vi) Creating is the ability to form a new pattern/ structure / theory so a new meaning can be 

established. A PhD students discover or invented a new and improved theory of current flow  
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Dave's psychomotor domain taxonomy (1975) 

The psychomotor domain involves development of hands on skills it performs. According 

to Dave (1975) this taxonomy contains five levels that are illustrated below. 

1. Imitation - Observing and copying someone else, like teacher demonstrate a task and 

students practice the same task as per the demo of the teacher. 

2. Manipulation – Doing task in presence of original source guided via instruction to 

perform a skill 

3. Precision - Accuracy, proportion and exactness exist in the skill performance without 

the presence of the original source. 

4. Articulation - Two or more skills combined, sequenced, and performed consistently. 

5. Naturalization - Two or more skills combined, sequenced, and performed consistently 

and with ease. The performance is automatic with little physical or mental exertion; this 

level is also treated as neutralization.  

Level 
Category or 

'level' 

Behavior 

descriptions 

Examples of 

experience, or 

demonstration and 

evidence to be 

measured 

'key words' 

(verbs which 

describe the 

activity to be 

trained or 

measured at each 

level) 

1 Imitation copy action of 

another; observe and 

replicate 

watch teacher or 

trainer and repeat 

action, process or 

activity 

copy, follow, 

replicate, repeat, 

adhere 

2 Manipulation reproduce activity 

from instruction or 

memory 

carry out task from 

written or verbal 

instruction 

re-create, build, 

perform, execute, 

implement 

3 Precision execute skill 

reliably, 

independent of help 

perform a task or 

activity with 

expertise and to high 

quality without 

assistance or 

instruction; able to 

demonstrate an 

activity to other 

learners 

demonstrate, 

complete, show, 

perfect, calibrate, 

control, 

4 Articulation adapt and integrate 

expertise to satisfy a 

non-standard 

objective 

relate and combine 

associated activities 

to develop methods 

to meet varying, 

novel requirements 

construct, solve, 

combine, 

coordinate, 

integrate, adapt, 

develop, 

formulate, modify, 

master 
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5 Naturalization automated, 

unconscious 

mastery of activity 

and related skills at 

strategic level 

define aim, approach 

and strategy for use 

of activities to meet 

strategic need 

design, specify, 

manage, invent, 

project-manage 

 

Affective domain: 

Most people think of learning as an intellectual or mental function. However, learning is 

not a just a cognitive (mental) function. You can also learn attitudes, behaviours, and 

physical skills. The affective domain involves feelings, emotions and attitudes. This 

domain includes the manner in which we deal with things emotionally, such as feelings, 

values, appreciation, enthusiasms, motivations, and attitudes.  This domain is categorized 

into 5 sub-domains, which include:  

(1). Receiving (2) Responding (3) Valuing (4) Organization (5) Characterization  

  

i) Receiving: The receiving is the awareness of feelings, emotions, and the ability to utilize 

selected attention.  Example:  Listening attentively to a friend. Listening attentively to 

someone; watching a movie, listening to a lecture; watching waves crash on the sand.  

ii) Responding to Phenomena: Responding is active participation of the learner. Example: 

Participating in a group discussion. Having a conversation; participating in a group 

discussion, giving a presentation, complying with procedures, or following directions.  

 iii) Valuing: Valuing is the ability to see the worth of something and express it. Valuing 

is concerned with the worth you attach to a particular object, phenomenon, behaviour, 

or piece of information.  This level ranges from simple acceptance to the more complex 

state of commitment.  Simpler acceptance may include your desire for a team to improve 

its skills, while more complex level of commitment may include taking responsibly for 

the overall improvement of the team.  Examples:  Proposing a plan to improve team 

skills, supporting ideas to increase proficiency, or informing leaders of possible issues. 

It is the ability to see the worth of something and express it.  Example: An activist shares 

his ideas on the increase in salary of laborers.  

iv) Organization: ability to prioritize a value over another and create a unique value 

system. Example: A teenager spends more time in her studies than with her boyfriend.  

v) Characterization: the ability to internalize values and let them control the person`s 

behaviour. Example: A man marries a woman not for her looks but for what she is. 

 

Level 
Category or 

'level' 
Behaviour 

descriptions 

Examples of 

experience, or 

demonstration and 

evidence to be 

measured 

'key words' (verbs 

which describe 

the activity to be 

trained or 

measured at each 

level) 
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1 Receive open to 

experience, 

willing to hear 

listen to teacher or 

trainer, take interest 

in session or learning 

experience, take 

notes, turn up, make 

time for learning 

experience, 

participate passively 

ask, listen, focus, 

attend, take part, 

discuss, 

acknowledge, hear, 

be open to, retain, 

follow, concentrate, 

read, do, feel 

2 Respond react and 

participate 

actively 

participate actively in 

group discussion, 

active participation in 

activity, interest in 

outcomes, 

enthusiasm for 

action, question and 

probe ideas, suggest 

interpretation 

react, respond, seek 

clarification, 

interpret, clarify, 

provide other 

references and 

examples, 

contribute, question, 

present, cite, 

become animated or 

excited, help team, 

write, perform 

3 Value attach values and 

express personal 

opinions 

decide worth and 

relevance of ideas, 

experiences; accept 

or commit to 

particular stance or 

action 

argue, challenge, 

debate, refute, 

confront, justify, 

persuade, criticise, 

4 Organise or 

Conceptualize 

values 

reconcile internal 

conflicts; 

develop value 

system 

qualify and quantify 

personal views, state 

personal position and 

reasons, state beliefs 

build, develop, 

formulate, defend, 

modify, relate, 

prioritise, reconcile, 

contrast, arrange, 

compare 

5 Internalize or 

characterise 

values 

adopt belief 

system and 

philosophy 

self-reliant; behave 

consistently with 

personal value set 

act, display, 

influence, solve, 

practice, 
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4. Pedagogy aspect for preparing session plan 

Pedagogy refers to the theory and practice of teaching, including the methods and 

strategies used to impart knowledge and skills to learners. In the context of competency-

based training, pedagogy is an essential aspect that helps ensure the training is effective 

and aligned with the learners' needs. 

Some Pedagogy Aspect for Planning Digital Learning Content are describing bellow: 

1. Use of appropriate lesson / session plan 

2. Use of appropriate action verb for writing instructional objectives /learning outcome 

3. Maintaining learning domains and their levels 

4. Sequencing the learning contents 

5. Using proper method, strategies and approach 

 

▪ Use of appropriate lesson/session plan: 

In developing digital content for competency-based training, it is essential to have a 

clear and well-structured lesson plan or session plan. This plan should outline the 

learning objectives, the activities and resources required to achieve those objectives, 

and the assessment methods to measure learner progress. A well-planned lesson or 

session helps ensure that learners stay engaged and motivated throughout the training, 

and that the training is delivered efficiently and effectively. 

▪ Use of appropriate action verb for writing instructional objectives/learning 

outcomes: 

When writing instructional objectives or learning outcomes for digital content, using 

appropriate action verbs is crucial. Action verbs help to describe the intended outcome 

of the training and provide a clear target for learners to aim for. Examples of appropriate 

action verbs for competency-based training include "analyze," "evaluate," "create," and 

"apply." These verbs help to ensure that learners are able to demonstrate their 

competence in performing specific tasks or skills. 

▪ Maintaining learning domains and their levels: 

Learning domains are the different areas of knowledge or skills that learners need to 

acquire during their training. Maintaining these domains and their levels is essential to 

ensure that learners receive comprehensive training that covers all the necessary 

knowledge and skills.  

 

▪ Sequencing the learning contents: 

Sequencing the learning contents is crucial to ensure that learners progress logically 

and gradually through the training. The content should be organized in a way that 

builds on previously learned concepts and skills. For example, in a digital marketing 

course, learners might start with basic content creation techniques, then progress to 

more advanced techniques, and finally learn how to analyze and optimize their 

campaigns. 
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▪ Using proper method, strategies, and approach: 

Using a proper method, strategy, and approach is essential to ensure that learners 

receive effective training that meets their needs and learning styles.  

 

5. Learning Materials Digitalization steps and sequences 

This area focuses on the detailed steps and sequences that should be followed to digitize 

learning materials effectively and efficiently. 

▪ Introductions 

Introductions are an important first step in any digital learning resource. They provide 

an opportunity to engage learners, introduce the subject, and set expectations. 

▪ Outline of Objectives/Content to be Addressed 

Creating an outline of objectives and content helps to structure your digital learning 

material and ensure that it covers all necessary areas. 

▪ Ice Breakers to be used 

Ice breakers are activities designed to get learners engaged and comfortable. They are 

especially useful in a digital learning environment where learners may initially feel 

isolated. 

▪ Delivery Methods for Each Part of the Session 

Different parts of your digital learning material may be best suited to different delivery 

methods. 

▪ Plan of Learning Activities to be Used Within the Session 

Learning activities are opportunities for learners to engage with the content, apply their 

knowledge, and build their skills. 

▪ Timelines/Duration for Each Learning Activity 

Effective timing can enhance the flow of your digital learning material and ensure that 

learners have adequate time for each activity. 

▪ Formative assessment points/opportunities 

Formative assessment is essential to ensure that learners have acquired the necessary 

knowledge and skills to progress to the next level of training. It provides an opportunity 

to identify any gaps in learning and address them before moving on to more advanced 

topics. Additionally, formative assessment helps to reinforce learning and promote 

retention of the material, making it a valuable tool for both the learners and the trainers. 

▪ Learning Materials Required 

In addition to the digital learning material itself, learners may need additional resources 

or materials to support their learning. 
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▪ Summary/overview/wrap-up: 

It is essential to ensure learners understand the key takeaways and can apply the skills 

and knowledge in their work. It provides a concise recap of the main points covered 

during the session, helping learners review and retain the information. 

 

6. Session plan preparing Procedure  

Preparing a session plan involves several steps.  

1. Define Learning Objectives: Start by clearly identifying the desired learning outcomes 

or objectives for the session. What specific knowledge, skills, or attitudes do you want 

participants to acquire or demonstrate? Ensure that your objectives are specific, 

measurable, achievable, relevant, and time-bound (SMART). 

Several factors need to be considered when writing the objectives of a learning outcome 

such as  

a. Clearly state intentions through outcomes (general and specific);  

b. The objectives will be determined and stated at the beginning of the lesion/ session 

with the common statement “At the end of the session the students/ trainee will 

able to:” 

c. Each of the specific objective will be start with appropriate action verb considering 

the levels of cognitive, psychomotor and affective learning domain 

d. The learning objectives should be Specific, Measurable, Achievable, Realistic and 

Time bound (SMART)  

e. The non-measurable and non-observable verb like know, understand, appreciate, 

value, develop should not be used during writing the learning objectives.   

2. Understand Your Audience: Consider the characteristics of your audience, such as 

their age, educational background, prior knowledge, and learning preferences. This 

information will help you tailor the session content and activities to their needs and 

ensure maximum engagement. 

3. Gather Relevant Resources: Collect the necessary resources, materials, and equipment 

required for the session. This may include textbooks, handouts, audiovisual aids, props, 

or technology tools. Ensure that these resources align with your learning objectives and 

support the planned activities. 

4. Determine Session Duration: Decide on the duration of the session, considering the 

content complexity, participants' attention span, and available time. Allocate sufficient 

time for each activity while allowing for transitions, breaks, and interaction. 

5. Structure the Session: Divide the session into segments or sections based on the content 

and learning objectives. Outline the flow and sequence of activities, ensuring a logical 

progression that maintains participants' interest and engagement. 

6. Plan Introduction and Prepare learner: Begin the session with an engaging 

introduction to capture participants' attention and establish the session's purpose. Include 

an icebreaker activity or a brief warm-up exercise to create a positive and interactive 

learning environment. 
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7. Develop Content Delivery Strategies: Determine the most appropriate instructional 

strategies to deliver the content and engage participants. Consider a mix of methods, 

such as lectures, discussions, multimedia presentations, case studies, demonstrations, or 

hands-on activities. Align these strategies with your learning objectives and the 

audience's preferences. 

8. Design Interactive Activities: Incorporate interactive activities throughout the session 

to encourage active participation and reinforce learning. These activities could include 

group work, role plays, brainstorming sessions, problem-solving exercises, or debates. 

Ensure that they align with the learning objectives and promote critical thinking and 

collaboration. 

9. Incorporate Assessment and Evaluation: Integrate various formative assessment 

methods to gauge participants' understanding and progress during the session. This could 

involve quizzes, polls, class discussions, or hands-on demonstrations. Determine how 

you will provide feedback and address any misconceptions or gaps in understanding. 

10. Plan Closure and Follow-up: Conclude the session effectively by summarizing the 

key points, reinforcing the learning outcomes, and allowing participants to ask questions 

or share their reflections. Provide guidance on any follow-up activities, assignments, or 

recommended resources to support continued learning beyond the session. 

11. Consider Adaptations and Contingencies: Anticipate potential challenges, diverse 

learning needs, or unforeseen circumstances. Plan for adaptations or modifications to 

accommodate different learners and have alternative activities or strategies ready as 

backup options. 

12. Review and Revise: Take the time to review and revise your session plan before 

implementation. Ensure that it is clear, concise, and well-structured. Seek feedback from 

colleagues or mentors, if possible, to gain different perspectives and make improvements 

as needed.  

 

7. Work Plan 

A work plan represents the formal road map / streamline a project for a project. It should 

clearly articulate the required steps to achieve a stated goal by setting demonstrable 

objectives and measurable deliverables that can be transformed into concrete actions. 

The purpose of workplan is to create a visual reference for the goal, objectives, tasks and 

team members who are responsible for each area. 

A work plan includes: 

▪ Setting goals and objectives 

▪ Establishing team responsibilities 

▪ Setting project timelines 

▪ Establishing a budget 
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Things to consider in making a plan: 

1) Define your goal in writing  

▪ According to research from Dominican University, people who write their goals 

down accomplish significantly more than those who don’t.  

▪ Use the SMART goals framework  

- Specific  

- Measurable  

-Achievable (but ambitious)  

- Relevant (and realistic)  

-Time-bound (or timely)  

▪ Using this framework will enable you to remove ambiguity around a goal and craft 

an action plan that spells out exactly what you need to do. 

 

2) Divide the goals into milestones  

When you have a roadmap that details what needs to happen, you’re more likely to 

stay motivated and committed throughout the process. 

 

3)  Identify the resources needed  

▪ Any action plan that doesn’t account for resources is akin to a wish list. 

▪ Identifying the resources needed to successfully act on your plan will enable you to 

make informed decisions regarding its implementation. 

 

Sample format of workplan: 

 

WORK PLAN 
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8. Study Guide 

A study guide condenses all those topics into a single source of information. It assists 

students' learning; students can study better by highlighting the most important topics 

and concepts. It is a useful document that is generally used by students of all ages. 

The purpose of a study guide is to help you synthesize and summarize the information. 

You might think of your study guide as a mini outline. It is especially useful for difficult 

or complex concepts or subject areas. The primary advantage of a study guide is that it 

reduces the amount of information to be learned. 

 

Sample format of study guide: 

 

DESIGN AND MODIFY CBT LEARNING MATERIALS AND RESOURCES 

 

Nominal Duration: 40 Hours 

Study Guide 

INTRODUCTION  

Welcome to this blended training of Design and modify CBT learning materials and 

resources. This unit covers the knowledge, skills and attitude required to design and 

modify CBT learning materials and resources. It includes analyzing existing learning 
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materials and relevant resources, adapting existing resources, developing new resources, 

reviewing learning materials and evaluating the design & development process. 

OBJECTIVES  

At the end of this module, you should be able to 

1. Analyze existing learning materials and relevant resources 

2. Adapt existing resources 

3. Develop new resources 

4. Review learning materials 

5. Evaluate the design and development process 

KEY CONCEPT 

Module 1: Analyze existing learning materials and relevant resources 

• Learning materials and resources  

• Relationship between learning outcomes and elements. 

• Adult learning 

• learning environment 

Module 2: Develop new resources 

• Developing relevant learning materials and resources 

• Learning Activities and Method 

• Effective Training or Learning Materials 

 

Module 3: Evaluate the design and development process 

• Checking content of the developed materials 

• Reviewing final draft  

• Evaluating the design and development process 

LEARNING RESOURCES  

1. Self-paced Learning Material (CBLM)  

2. LMS  

3. Task Sheets and Performance Criteria Checklist 

STUDY QUESTIONS  

Module 1: Analyze existing learning materials and relevant resources 

1. Why we use learning materials?  

2. Write Down the major parts of CBLM?  

3. What is learning materials?  

4. What is learning Outcome 

5. Write down the principle of adult learning? 

6. Why need review Existing Learning materials?  

7. What is operational Resources?  

8. What are Consumable resources?  

9. What is CBLM? 

10. What are the major parts of CBLM’s?  

11. What is job sheet and specification sheet?  

Module 2: new resources 

1. Write down the nine steps that can assist you in your writing?  
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2. Why Self Tests, Quizzes and Questionnaires use? 

3. What are the things considering that you need when preparation for 

writing CBLM? 

4. How can you improve your Writing? 

Module 3: design and development process 

1. Why need Revision and Amendment of CBLM  

2. What is Utilization Criteria for emulation CBLM?  

3. What is Technical Criteria for emulation CBLM? 

 

ACTIVITIES 

A. Face to face Activities (guided online activities)  

Module 1: learning materials and resources 

a. Face to face discussion on the importance of learning materials and resources on 

Designing and modifying CBT learning materials and resources.  

b. Access the Learning Management System (LMS), https://ecampusrisda.org/ 

c. Take the Pre-Test 

d. Read the Power point presentation about CBLM. 

e. Perform Task Sheet No. 8.1 Collect and access existing learning materials and 

resources 

f. Perform Task Sheet No. 8.2 Modify training resources and aid. 

 

Module 2: new resources 

a. Face to face discussion about Learning materials and resources.  

b. Perform Task Sheet No. 8.3 Develop relevant learning materials and resources 

c. Perform Task Sheet No. 8.4 Review draft learning materials and resources 

 

Module 3: design and development process  

a. Face to face discussion on management and issues encountered  

b. Perform Task Sheet No. 8.5 Evaluate the design and development process  

 

B. Offline Activities  

1. Finalization of task sheets, assessment of activities and oral questioning.  

2. Feedbacking, facilitating.  

3. Share and discuss key takeaways and new learnings from the course. 

 

REFERENCES:  

1. CBLM, Design and modify CBT learning materials and resources 

2. https://moodle.org/  

 

https://ecampusrisda.org/
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9. Course Blue Print 

A course blueprint is a visual representation of a course that outlines its key components 

and how they fit together. It's part of a larger course design portfolio and helps ensure that 

the course is well-structured and coherent. 

It is a way for an instructor to map out the different aspects of teaching and learning 

which go into a given course, thus providing an opportunity to articulate and “draw,” so to 

speak, a holistic picture of the course. 

This can be helpful for the instructor’s own course design and course revision efforts, 

as well as for discussions with colleagues regarding the course and how it fits into the 

program curriculum as a whole. It can certainly inform the way that an instructor crafts the 

syllabus which they share with students.  

 

The Course Blueprint may include:  

i. Course Description: It is likely that your institution’s course catalog provides a broad 

description of your course.  

ii. Learning Objectives – Specified abilities that students will be able to achieve; the 

behaviors that students will be able to perform after completing the course. These must 

be observable and measurable, and criteria for their measurement should be described 

in a rubric.  

iii. Learning Experience/Activities– Activities designed to assist students in achieving 

the learning objectives. These activities may be passive or active.  

iv. Evaluation Plan – Assignments, tests, and grading system developed by the instructor 

used to assess how students reach the course learning objectives. 

 

Sample template of course blue print 

 

COURSE BLUE PRINT 
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10. Instructional design 

Instructional design is a framework to creation of instructional materials. Though, this field 

goes beyond simply creating teaching materials, it carefully considers how students learn 

and what materials and methods will most effectively also what technology use to help 

individuals achieve their academic goals. 

Instructional design (ID) is based on three psychological principles of learning: 

▪ Behavioral 

▪ cognitive and 

▪ constructivist. 

Behavioral psychology advocates repetition and reinforcement in learning material to 

create a "behavior" in the learner. Cognitive psychology focuses on engaging the learner's 

senses to create a learning process, while constructivism emphasizes the learner's own 

experience and personal interpretation. To create a solid foundation for delivering these 

principles, learning materials should: 

▪ Present content. 

▪ Guide the learner in practice. 

▪ Provide for independent practice by the learner. 

▪ Assess how well the learner is doing. 
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And be supported by interactivity between learner and program, and the motivation of the 

learner. Skilled instructional designers know that the learning content shouldn't become 

secondary to the technology that delivers it. They also activate prior learning, demonstrate 

what's new, give learners opportunities to apply their new learning, and integrate current 

with previous learning.  

Sample template of course instructional design 

 

11. Courseware: 

The combination of 2 words: course and software made courseware. It is one of the 

educational software. Courseware is educational material designed as tools for teachers or 

trainers or as tutorials for students, usually packaged for use with a computer.  Courseware 

refers to educational material used in the delivery of courses, lessons, or training programs. 

This material can take the form of multimedia content, including text, images, audio, and 

video, and is often used in online or distance learning environments.  

Courseware is a great assistant for teachers since they present a lot of information that are 

hard to be communicated by spoken words. 

For teachers and trainers, courseware content may include set-up information, a course 

plan, teaching notes, and exercises. Courseware can include: 

▪ Slides for instructor-led classes. 

▪ Material for self-directed computer-based training (CBT). 

▪ Web sites that offer interactive tutorials. 

▪ Material that is coordinated with distance learning, such as live classes conducted over 

the Internet. 

▪ Videos or slides for use individually or as part of classes. 

  



 

37 

 

Purpose of Courseware: 

The primary purpose of courseware is teaching or self-learning.  

It provides students with the information and resources they need to learn and understand 

a subject, as well as to assess their progress and understanding through tests, quizzes, and 

assignments. 

Main reason for courseware: 

▪ Technology is one of the biggest reasons for courseware 

Train employee/trainee with new tricks 

▪ Technology is always increasing 

Some questions about courseware: 

▪ Who uses courseware? 

Manager/trainer to train employees/trainees 

▪ Where is it used? 

Any organization that feels the need to train their staff/trainee 

▪ When it is used? 

When technology increased and employees/trainees need to update their skills 

Principle of courseware design: 

There are 3 Principles in courseware design 

a. Sound Instructional Plan - gives targets, learning objectives and goals  

b. Adults learn best by doing - Define, Show, Do, Review  

c. Learning experience is set up for the individual so there is maximum retention of 

the information to be learned 

 

 

Sample template of course courseware 

 

COURSEWARE 
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12. Structure and Segmentation of Digital Contents 

The structure and segmentation of digital content is a key factor in how 

effectively learners can absorb and understand the information presented. 

Well-structured content contributes to a more engaging and effective learning 

experience. 

▪ Clear Organization 

Organization in digital content refers to how the content is structured and ordered, including 

the grouping of similar topics and the logical flow from one topic to another. 

▪ Chunking Information 

Chunking refers to breaking down information into smaller, manageable parts or 'chunks'. 

This technique makes content easier to digest and remember, making it particularly useful 

for complex or dense topics. 

▪ Sequential Flow 

Sequential flow refers to arranging the content in a logical and linear order, where each topic 

builds on the previous one. 

 

Sector  : Training & Assessment 

Qualification :   NC level 4 in Competency Based Training and Assessment  

Unit of Competency:  
 TVTDES401A1: Design and modify CBT learning materials and 
resources 

Module Title Analyzing existing learning materials and relevant resources 

Developer:  Md. Anisuzzaman 

  

Learning Objective/s: 

 

At the end of the module, learners should be able to analyze existing 
learning materials and relevant resources 

 

Learning 
Outcomes 

W E B S C R I P T MEDIA SCRIPT REMARKS 

Lesson/s Topics 
Assignme

nt 
Unit Quiz 

Text/Image/A
udio 

Video  

Analyze 
existing 
learning 
materials 
and 
relevant 
resources 

 

Collecting 
and 
accessing 
existing 
learning 
materials 
and 
resources 

Learning 
Materials 
and 
Resources 

 

7.1 
Collect 
and 
access 
existing 
learning 
materials 
and 
resources 

Short 
questions 
on 
Learning 
Materials 
and 
Resources 

Slide 
Presentation 
on Learning 
materials & 
resources 
and 
Relationship 
between 
learning 
outcomes 
and elements 

Video on 
collection 
and 
accessing 
of existing 
learning 
materials 
and 
resources 

 

 

 

 



 

39 

 

▪ Navigation and Signposting 

Navigation and signposting help guide learners through the content. They include elements 

like a table of contents, breadcrumb trails, navigation buttons, and clear headers and sub-

headers. 

▪ Visual Hierarchy 

Visual hierarchy in digital content refers to the use of design elements to indicate the 

importance of content. It helps learners identify key points and understand how information 

is related. 

▪ Interactive Elements 

Interactive elements, such as quizzes, discussions, and interactive graphics, can increase 

engagement and improve learning outcomes. 

▪ Consistent Design 

Consistent design enhances usability and learner confidence by making content predictable 

and easier to understand. 

 

13. Technology, Pedagogy and Content Knowledge (TPACK) principles 

At the heart of good teaching with technology are three core components: content, pedagogy, 

and technology, plus the relationships among and between them. The interactions between 

and among the three components, playing out differently across diverse contexts, account 

for the wide variations seen in the extent and quality of educational technology integration. 

These three knowledge bases (content, pedagogy, and technology) form the core of the 

technology, pedagogy, and content knowledge (TPACK) framework. 

TPACK stands for Technological Pedagogical Content Knowledge. It is a framework that 

describes the knowledge and skills that teachers need to effectively integrate technology into 

their teaching practices. The TPACK framework recognizes that technology, pedagogy, and 

content are interconnected and that effective teaching with technology requires a deep 

understanding of these intersections. It suggests that teachers need to know not only about 

the technology itself, but also how to use it to support learning, and how to align technology 

use with the curriculum and learning objectives. 

The main domains of TPACK are 1. Technological Content Knowledge (TCK); 2. 

Pedagogical Content Knowledge (PCK), and 3. Technological Pedagogical Knowledge 

(TPK). The three subdomains are 1. Technological Knowledge (TK); 2. Content Knowledge 

(CK); and 3. Pedagogical Knowledge (PK). In 2019, Mishra proposed a revised TPACK 

diagram to emphasize the context in which technology integration occurs by retitling the 

outer circle as Contextual Knowledge or XK. 
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TPACK is a framework that identifies the knowledge teachers need to teach effectively with 

technology. 

 

▪ Content Knowledge (CK) 

Content Knowledge refers to the teacher's understanding of the subject matter that is to be 

learned or taught. This includes knowledge of concepts, theories, ideas, organizational 

frameworks, knowledge of evidence and proof, etc. 

▪ Pedagogical Knowledge (PK) 

Pedagogical Knowledge involves understanding how to facilitate learning. This includes 

knowledge of teaching methods, lesson planning, learner assessment, and classroom 

management strategies. 

▪ Technological Knowledge (TK) 

Technological Knowledge involves understanding of various technologies, software, 

hardware, and tools that can be used in teaching. 

▪ Technological Pedagogical Knowledge (TPK) 

Technological Pedagogical Knowledge refers to an understanding of how teaching and 

learning can change when particular technologies are used. This includes knowing the 

pedagogical affordances and constraints of a range of technological tools as they relate to 

disciplinarily and developmentally appropriate pedagogical designs and strategies. 
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▪ Technological Content Knowledge (TCK) 

Technological Content Knowledge refers to an understanding of the relationship between 

your subject matter and the technology that can be used to communicate it. 

▪ Technological Pedagogical Content Knowledge (TPACK) 

Technological Pedagogical Content Knowledge represents a class of knowledge that is 

central to teachers’ work with technology. The interaction of these three types of 

knowledge - content, pedagogy, and technology - both with each other and with the 

context, creates the knowledge base necessary for effective teaching with technology. 

 

14. Digital Learning Materials/Media Elements 

Digital learning materials or media elements like text, images, video, audio, and interactive 

content enhance digital learning experiences. They cater to diverse learning styles, improve 

information retention, and make learning interactive and engaging. 

Types of Media Elements 

There is an array of media elements that can be used in digital learning, including but not 

limited to text, images, videos, audio, animations, infographics, quizzes, interactive 

simulations, augmented reality (AR), virtual reality (VR), and social media elements. 

▪ Text 

Text is a vital component of digital learning materials. Text is a collection of words or letters 

that are understandable by the reader. On a computer, text is added, viewed, edited, and 

modified. It can be used to deliver crucial information, instructions, explanations, and more. 

▪ Images (Graphics) 

Images, including photographs, diagrams, infographics, and illustrations, can supplement 

textual content and aid comprehension. They can be created or edited using tools like Adobe 

Photoshop, Canva, Adobe Illustrator etc. 

▪ Videos 

Videos, including tutorials, demonstrations, animated explainers, or recorded lectures, can 

enhance understanding and retention. They can be created using tools like Adobe Premiere 

Pro or simpler alternatives like Lumen5. 

▪ Audio 

Audio elements, such as podcasts, narrations, or sound effects, can offer a different mode of 

content delivery. Audacity or GarageBand can be used to create and edit audio content. 

 

▪ Interactive Content 

Interactive content such as quizzes, simulations, drag-and-drop activities, or clickable 

infographics can boost learner engagement and retention. Tools like Articulate Storyline or 

Adobe Captivate can be used to create interactive elements. 
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15. Types of Presentation for Digital Learning Production 

Digital learning offers various presentation types, each offering unique advantages. The 

choice of presentation type depends on factors such as the subject matter, learning objectives, 

learner preferences, and available resources. Type of presentation are illustrating bellow: 

▪ Slideshow Presentations 

Slideshow presentations, typically using PowerPoint, Keynote, or Google Slides, are a 

staple in many learning environments. They allow for the systematic presentation of 

information, often supplemented with images, audio, video, and interactive elements. 

▪ Video Presentations 

Video presentations can include recorded lectures, animated explainer videos, or 

demonstration videos. They are particularly effective when visual demonstration or 

storytelling is necessary for understanding. 

▪ Interactive Multimedia Presentations 

Interactive multimedia presentations integrate various media types and interactive elements 

like quizzes, simulations, or clickable infographics. Tools like Adobe Captivate or 

Articulate Storyline can be used to create these. 

▪ Webinars and Live Streaming 

Webinars and live streams provide real-time interaction between the presenter and the 

audience, making them ideal for live lectures, discussions, or Q&A sessions. 

▪ Augmented Reality (AR) and Virtual Reality (VR) Presentations 

AR and VR offer immersive, experiential learning experiences, well-suited for fields like 

medicine, engineering, or history. They require specialized tools and equipment, such as 

Unity for creating the presentations and VR headsets for experiencing them. 

▪ Podcasts and Audio Presentations 

Podcasts and audio presentations allow learners to absorb information while multitasking. 

They are effective for storytelling, interviews, or narrative-driven content. 

 

▪ E-books and Digital Textbooks 

E-books and digital textbooks provide text-heavy, self-paced learning resources. They can 

be supplemented with images, interactive elements, and embedded multimedia. 
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16. Digital Learning Production Phase 

The production of digital learning content can be broadly divided into three phases: 

preproduction, production, and post-production. Each phase involves specific tasks that 

contribute to the overall quality and effectiveness of the final learning material 

16.1 Preproduction 

The preproduction phase is the planning stage. This involves conceptualizing the content, 

defining learning objectives, and outlining the course structure. This phase often includes 

creating a detailed storyboard or script and setting up a production timeline. 

Work Instructions: 

Step 1: Begin by identifying the learning objectives and target audience for your digital 

learning content. 

Step 2: Create a detailed outline or storyboard of the content. This should include the 

sequence of topics, the types of learning materials (text, video, audio, interactive elements), 

and any assessment methods. 

Step 3: Develop a production timeline that outlines when each task needs to be completed. 

 

16.2 Production 

The production phase is when the actual creation of the digital learning content occurs. This 

can include writing, recording, designing, coding, and more, depending on the type of 

content being produced. 

Work Instructions: 

Step 1: According to your storyboard or script, start creating the content for your digital 

learning material. 

Step 2: This can involve writing text, recording audio or video, designing visuals or 

graphics, and creating any interactive elements. 

Step 3: Ensure you follow the best practices for each type of content. For example, for 

video content, ensure good lighting and audio quality. 

16.3 Post Production 

In the post-production phase, the raw materials created during the production phase are 

edited and polished. This can include adding effects or enhancements, testing the material, 

gathering initial feedback, and making necessary revisions. 
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Work Instructions: 

Step 1: Review the content created during the production phase and perform necessary 

edits. This could include editing video or audio, proofreading text, and testing interactive 

elements. Step 2: Add any final enhancements such as transitions, effects, or additional 

multimedia elements. 

Step 3: Test the digital learning content and gather feedback. Based on this feedback, make 

any necessary revisions to improve the content's quality and effectiveness. 

 

17. Content Development Software 

The production of digital learning content involves the use of various content development 

software. Each type of software has a specific role in the creation, editing, or organization 

of different content types. 

17.1 Word Processors 

A word processor is a device or software program capable of creating, storing, and 

printing text documents. It allows users to write and modify text, display it on a screen, 

save it electronically, and print it out. 

Example: 

▪ Microsoft Word 

▪ Google Docs 

▪ iWork Pages 

▪ OpenOffice Writer 

▪ WordPerfect etc. 

 

17.2 Image Editors 

An image editing software that enables the creating, editing and conversion of images 

to varying graphic formats. It can used for tasks ranging from simple cropping or resizing 

to complex graphic design. Everyone knows Photoshop as one of the most popular image 

editing tools, but there are many others with similar capabilities.  

Example: 

▪ Adobe Photoshop. 

▪ Adobe Photoshop Lightroom. 

▪ Canva for Enterprise. 

▪ Photos. 

▪ Adobe Photoshop Lightroom Classic. 

▪ Photoshop Elements. 

▪ Adobe Photoshop Express. 

▪ GIMP etc 



 

45 

 

 

17.3 Video Editors 

Video editors are essential for creating and editing videos, an increasingly important 

component of digital learning content. 

Example: 

▪ Adobe Premiere Pro. 

▪ Final Cut Pro X. 

▪ Adobe After Effects. 

▪ Lightworks. 

▪ Freemake. 

▪ iMovie. 

▪ Shotcut etc 

 

17.4 Audio Editors 

Audio editors are used for recording or editing sound files, such as voice-overs for videos 

or audio for podcasts. 

Example: 

▪ Riverside.fm. 

▪ Logic Pro X. 

▪ Adobe Audition. 

▪ GarageBand. 

▪ Audacity. 

▪ Descript. 

▪ Ableton Live etc. 

 

17.5 Screen casting Software 

Screen casting software is used to create screencasts, which are video recordings of your 

computer screen. They are often used for software tutorials or demonstrations. 

 Example: 

▪ Camtasia 

▪ ScreenFlow 

▪ Loom 

▪ OBS Studio 

  

https://sellcoursesonline.com/best-screencasting-software#1-camtasia
https://sellcoursesonline.com/best-screencasting-software#3-screenflow
https://sellcoursesonline.com/best-screencasting-software#6-loom
https://sellcoursesonline.com/best-screencasting-software#7-obs-studio
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18. Content Development/Authoring Tools 

Developing digital learning content often requires specialized authoring tools. These tools 

allow for the creation of structured, interactive learning experiences, such as online courses, 

quizzes, or assessments. 

 

18.1 Course Authoring Tools 

Course authoring tools are software applications used to create online courses. These 

tools typically offer features for creating and organizing content, incorporating 

multimedia elements, and building interactive components. 

 Example: 

▪ Elucidat  

▪ Articulate Rise  

▪ Easygenerator  

▪ Articulate Storyline  

▪ Adobe Captivate. 

 

18.2 Quiz Creation Tools 

Quiz creation tools allow you to create quizzes or assessments to test learners' 

understanding of the content. These tools often provide options for multiple question 

types, automatic grading, and feedback. 

Example: 

▪ Google Forms 

▪ Quizizz 

▪ Slido 

▪ SurveyMonkey 

▪ Playbuzz 

▪ Typeform, etc 

 

 

  

https://www.slido.com/
https://www.slido.com/
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Self-Check Sheet 2: Plan for digital learning contents development  

 

 

1. What is the ADDIE model used for in instructional system design? What are the five phases 

of this model? 

 

2. What is learning domain? According to Bloom's Taxonomy what are the three parts of 

learning domain? 

 

3. According to Bloom's Taxonomy, how many levels of cognitive domain are there in total? 

List and explain them in order from lowest to highest?  

 

4. What is work plan? What is the purpose of a work plan? 

 

5. What are the key elements of a work plan? 

 

6. What is the purpose of study guide? 

 

7. What is course blue print? 

 

8. Which elements should be included in course blue print? 

 

9. How many principles in courseware design? Explain each of them. 

 

10: What is TPACK and why is it important for effective teaching with technology? 

 

11. What are the main domains of TPACK? 

 

12. What is Contextual Knowledge (XK) in the revised TPACK diagram proposed by Mishra 

in 2019? 
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Answer Key 2: Plan for digital learning contents development  

 

1. What is the ADDIE model used for in instructional system design? What are the five 

phases of this model? 

 

Answer: The ADDIE model is used as a framework for creating high-quality, effective 

digital learning materials. 

The five phases of the ADDIE model are Analysis, Design, Development, Implementation 

and Evaluation. 

 

2. What is learning domain? According to Bloom's Taxonomy what are the three parts of 

learning domain? 

Answer: A domain is a particular field of thought, activity, or interest, especially one over 

which someone has control, influence, or rights. 

 

According to Bloom's Taxonomy there are three parts of learning domain. These are:  

1. Cognitive domain (intellectual capability, i.e., knowledge, or 'think’) 

2. Affective domain (feelings, emotions and behavior, i.e., attitude, or 'feel’)  

3. Psychomotor domain (manual and physical skills, i.e., skills, or 'do') 

 

 

3. According to Bloom's Taxonomy, how many levels of cognitive domain are there in 

total? List and explain them in order from lowest to highest?  

Answer: According to Bloom's Taxonomy, there are 6 levels of cognitive domain are there 

in total. These are: 

i) Remembering is the ability to recall data and/or information. Example: A children recites 

a rhythm in different language without understanding anything  

ii) Understanding is the ability to understand the meaning of what is known. Example: a 

student interprets the ohm’s law to his teacher. 

iii) Applying is the ability to utilize an abstraction or to use knowledge in a new situation. 

Example: Calculate current, voltage and resistance what he learned about ohm’s law and 

interpreted to his teacher.  

iv) Analysing is the ability to differentiate facts of the relationship of current, voltage and 

resistance 

v)  Evaluating is the ability to come up with judgments about the importance of concepts 

and integrate different elements or concepts. Examples: Explain the reasoning of 

variation of values of the electrical quantities in different situation 

vi) Creating is the ability to form a new pattern/ structure / theory so a new meaning can be 

established. A PhD students discover or invented a new and improved theory of current 

flow  



 

49 

 

 

4. What is work plan? What is the purpose of a work plan? 

Answer:  A work plan represents the formal road map / streamline a project for a project. It 

should clearly articulate the required steps to achieve a stated goal by setting demonstrable 

objectives and measurable deliverables that can be transformed into concrete actions. 

The purpose of a work plan is to create a visual reference for the goal, objectives, tasks, and 

team members who are responsible for each area. 

5. What are the key elements of a work plan? 

Answer: The key elements of a work plan include setting goals and objectives, establishing 

team responsibilities, setting project timelines, and establishing a budget. 

6. What is the purpose of study guide? 

Answer: The purpose of a study guide is to help you synthesize and summarize the 

information. The primary advantage of a study guide is that it reduces the amount of 

information to be learned. 

7. What is course blue print? 

Answer: A course blueprint is a visual representation of a course that outlines its key 

components and how they fit together. It's part of a larger course design portfolio and helps 

ensure that the course is well-structured and coherent. 

8. Which elements should be included in course blue print? 

Answer: The Course Blueprint may include:  

i. Course Description: It is likely that your institution’s course catalog provides a broad 

description of your course.  

ii. Learning Objectives – Specified abilities that students will be able to achieve; the 

behaviors that students will be able to perform after completing the course. These must 

be observable and measurable, and criteria for their measurement should be described 

in a rubric.  

iii. Learning Experience/Activities– Activities designed to assist students in achieving 

the learning objectives. These activities may be passive or active.  

iv. Evaluation Plan – Assignments, tests, and grading system developed by the instructor 

used to assess how students reach the course learning objectives. 
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9. How many principles in courseware design? Explain each of them. 

Answer: There are 3 Principles in courseware design. These are: 

a. Sound Instructional Plan - gives targets, learning objectives and goals  

b. Adults learn best by doing - Define, Show, Do, Review  

c. Learning experience is set up for the individual so there is maximum retention of 

the information to be learned 

 

10: What is TPACK and why is it important for effective teaching with technology? 

Answer: TPACK stands for Technological Pedagogical Content Knowledge, and it refers 

to the knowledge and skills that teachers need to effectively integrate technology into their 

teaching practices. It is important because technology, pedagogy, and content are 

interconnected, and effective teaching with technology requires a deep understanding of 

these intersections. 

 

11. What are the main domains of TPACK? 

Answer: The main domains of TPACK are Technological Content Knowledge (TCK), 

Pedagogical Content Knowledge (PCK), and Technological Pedagogical Knowledge 

(TPK). 

 

12. What is Contextual Knowledge (XK) in the revised TPACK diagram proposed by 

Mishra in 2019? 

Answer: Contextual Knowledge (XK) refers to the knowledge and skills that teachers need 

to effectively integrate technology into their teaching practices in a specific context. The 

revised TPACK diagram emphasizes the importance of considering the context in which 

technology integration occurs. 
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Task Sheet 2.1: Make work plan 

 

TASK SHEET 2.1 

Title: Make a Work Plan 

Performance Objective: At the end of this task, the trainee should be able to make a work 
plan for the for the development of digital contents for face-to-face delivery Following the 
steps and procedures given below. 

A. Supplies Documents 

▪ Sample format of workplan 

▪ Learning site, development site, Microsoft word 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 
 

C. Equipment: 

▪ Laptop/Computer 

 

Steps/Procedures: 

• Follow the given template of work plan in information sheet. 

• In paper and pen, identify your project name (project title), its purpose, time 

frame. 

• and budgetary requirement. 

• Identify your goals and objectives. 

• Identify your resources, risks and possible accountability. 

• Consolidate your ideas into context.  

• Fill in the required information on the table. 

• Convert your output into a pdf file. 

• Upload and wait for it to be evaluated by your trainer. 
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Specification sheet 2.1: Make work plan 

 

A. Supplies Documents 

▪ Sample format of work plan 

▪ Learning site, development site, Microsoft word 

 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Task Sheet 2.2: Prepare a Study Guide  

 

TASK SHEET 2.2 

Title: Prepare a Study Guide 

Performance Objective: At the end of this task, the trainee should be able to prepare a 
comprehensive study guide considering the given sample in information sheet. 

A. Supplies Documents 

▪ Sample format of study guide 

▪ Learning site, development site, Microsoft word 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 
 

C. Equipment: 

▪ Laptop/Computer 

 

Steps/Procedures: 

• Enumerate key ideas as highlight to study by your trainees. 

• Include nominal duration, introduction, objectives and learning resources. 

• Specific study questions for each module you wish to create should be listed 

there,  

• activities specifically for face-to-face classes should be provided in a very 

specific  

• and in chronological order.  

• Provide study schedule in the table on the template provided. Don’t forget to 

put  

• number of hours the activity should be covered.  

• Create your study guide in a word document then turn it into a pdf file. 

• Upload and wait for it to be evaluated by your trainer. 
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Specification sheet 2.2: Prepare a Study Guide 

 

A. Supplies Documents 

▪ Sample format of study guide 

▪ Learning site, development site, Microsoft word 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Task Sheet 2.3: Construct Course Blue Print  

 

TASK SHEET 2.3 

Title: Construct Course Blue Print 

Performance Objective: At the end of this task, the trainee should be able to construct course 
blue print considering the given sample in information sheet. 

A. Supplies Documents 

▪ Sample format of course blue print 

▪ Learning site, development site, Microsoft word, Training Needs Analysis 

(TNA) 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 
▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 

 

Steps/Procedures: 

• Use the Training Needs Analysis (TNA) as your basis to set the training goals. 

• Set achievable target/s based on your trainees’ capability. 

• Do not forget to put the title of your qualification, sector, unit of competency 

and  

• the module title.  

• Flow chart will help the trainees to identify the context of the training for each  

• unit of competency. 

• Use the given template. 

• Convert your output into a pdf file. 

• Upload and wait for it to be evaluated by your trainer. 
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Specification sheet 2.3: Construct Course Blue Print 

 

A. Supplies Documents 

▪ Sample format of study guide 

▪ Learning site, development site, Microsoft word, Training Needs Analysis (TNA) 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Task Sheet 2.4: Develop Instructional Design  

 

TASK SHEET 2.4 

Title: Develop Instructional Design 

Performance Objective: At the end of this task, the trainee should be able to Develop 
Instructional Design considering the given sample in information sheet. 

A. Supplies Documents 

▪ Sample format of course blue print 

▪ Learning site, development site, Microsoft word 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 
 

C. Equipment: 

▪ Laptop/Computer 

 

Steps/Procedures: 

• Fill-in the template given to you. 

• Do not forget to put the sector, qualification, unit of competency, module title. 

• Course descriptor and your name as developer on the first part of the table. 

• Contextualize each learning outcome, the topic, its content, the resource which 

will be the multimedia. 

• Please take note that, you don’t have to fill all types of multimedia. Be specific 

with your activities. 

• Convert your output into a pdf file. 

• Upload and wait for it to be evaluated by your trainer. 
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Specification sheet 2.4: Develop Instructional Design 

 

A. Supplies Documents 

▪ Sample format of study guide 

▪ Learning site, development site, Microsoft word, Training Needs Analysis (TNA) 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Task Sheet 2.5: Outline Courseware Content  

 

TASK SHEET 2.5 

Title: Develop Instructional Design 

Performance Objective: At the end of this task, the trainee should be able to Outline 
Courseware content considering the given sample in information sheet. 

A. Supplies Documents 

▪ Sample format of course blue print 
▪ Learning site, development site, Microsoft word 

 

B. Tools and Material required: 

▪ Notebook 
▪ Handbook 

▪ Office Stationeries 

 
C. Equipment: 

▪ Laptop/Computer 

Steps/Procedures: 

• Fill-in the template given to you. 

• Do not forget to put the sector, qualification, unit of competency, module title, 

your name as developer on the first part of the table and learning objectives. 

• Identify all learning outcomes of your unit of competency. Determine relevant 

lesson and include at least 2 or more topics per LO. Assignment may be in a 

form of self-check which include number control number and for numbering 

system follow this rule: Unit of Competency, Learning Outcome and then Topic 

(e.g., Self-Check: 5.3-2) wherein, 5 is the UoC, 3 is the learning outcome and 2 

is the number of topics. 

• For the portion of media script just put a check mark (✓) to which the topic 

applies. You may choose one from the two choices.  

• You may put remarks at the end column of the table for future references. 

• Convert your output into a pdf file. 

• Upload and wait for it to be evaluated by your trainer 
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Specification sheet 2.5: Outline Courseware content 

 

A. Supplies Documents 

▪ Sample format of study guide 

▪ Learning site, development site, Microsoft word 
 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Learning Outcome 3: Collect Media Elements  
 

Assessment Criteria:  

1. Sources of media elements for the presentation are selected and collected. 

2. Media elements are downloaded or collected from appropriate source. 

3. Media elements are manipulated and edited as required. 

4. Video is cut and appended as required to use in presentation. 

5. Open educational resources (OER) are selected and collected 
 

Content:  

1. Guidelines for Selecting Media Elements 

2. Researching and Validating Media Sources  

1.1. Reliable Media Sources 

1.2. Downloading/Collecting Process of Media Elements 

2.3. Assessing Media Quality and Relevance 

3. Legal and Ethical Guidelines for Media Usage 

4.1. Understanding Copyrights and Fair Use 

4.2. Citing and Acknowledging Media Sources 

4. Accessibility and Universal Design in Media Selection 

5.1. Principles of Accessible Media 

5.2. Inclusive Design in Media Selection 

5. Accessing OER (Open Educational Resources)  
 

Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  

 Methodologies  

▪ Lecture/discussion  

▪ Demonstration/application  

▪ Presentation 

▪ Blended delivery methods   

Assessment Methods 

▪ Written test   

▪ Demonstration  

▪ Observation with checklist  

▪ Oral questioning  

▪ Portfolio  
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Learning Experience 3: Collect Media Elements 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Collecting 

Media Elements. 

1. Instructor will provide the learning materials 

“Developing Digital Learning Materials” 

2. Read the Information sheet/s 
2. Information Sheet No 3: Collect Media Elements 

3. Complete the Self Checks & 

Check answer sheets. 

3. Self-Check/s 

Self-Check No 3: Collect Media Elements 

Answer key No. 3: Collect Media Elements 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No 3-1: Collect Media Elements 

 

Specification Sheet 3-1: Collect Media Elements 
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Information Sheet 3: Collect Media Elements  

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Select and collect Sources of media elements for the presentation. 

2. Download or collect Media elements from appropriate source. 

3. Manipulate and edit Media elements as required. 

4. Cut and append Video as required to use in presentation. 

5. Select and collect Open Educational Resources (OER)  

 

Content: 

1. Guidelines for Selecting Media Elements 

Selecting the right media elements can be the difference between effective and ineffective 

digital learning content. Media elements should be chosen carefully to support learning 

objectives, cater to diverse learning styles, engage learners, and enhance content 

comprehension. 

Work Instructions: 

Step 1: Identify your learning objectives. What knowledge or skills do you want your 

learners to acquire? How can media support these objectives? 

Step 2: Understand your learners. Consider their age, cultural backgrounds, literacy levels, 

accessibility needs, and learning styles. These factors can influence the types of media 

elements that will be most effective. 

Step 3: Select high-quality media elements that are relevant to the content, appropriate for 

the learners, and supportive of the learning objectives. 

2. Researching and Validating Media Sources 

2.1 Reliable Media Sources 

When sourcing media for your digital learning content, it's vital to use reliable and credible 

sources. This will ensure that the information you're providing is accurate and of high 

quality. 

Work Instructions: 

Step 1: Identify potential sources for your media elements. This could be databases, 

libraries, online platforms, or commissioned work. 

Step 2: Evaluate each source for its reliability. Consider factors such as the author's 

credibility, the source's reputation, and the quality and accuracy of the content. 

Step 3: Always cross-check information across multiple sources when possible. 
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2.2 Downloading/Collecting Process of Media Elements 

Downloading Files from Web 

The process of copying a file (such as a game or utility) from one computer to another 

through the internet is known as downloading. The transmission of a file from a server 

or remote computer system to a user’s PC is known as downloading. Downloading a 

file, from the perspective of an Internet user, is making a request for a file from a server 

computer and receiving it. When you download a game from our website, you are 

transferring it from the author’s or publisher’s web server to your own computer. This 

enables you to install and run the software on your own computer. Using Download, 

Click Here, etc. types of links on Web pages, downloading photos, articles, and apps 

from the Internet has become a pleasure. 

Steps to Download a File: 

To download a file (from a remote server), perform the following steps: 

Step 1: Select the software you wish to download by clicking on the download link. 

There are different websites that may provide download URLs for the same program, 

select one from them. Example: To download zoom on Windows: Go to the URL: 

“https://zoom.us/download” and then click on the download button. 

 

 

Step 2: You might be prompted whether you wish to save or run the file from its present 

location. Select “Save” (if asked). 

Note: Some browsers will choose “Save” for you automatically.  

Step 3: A regular “Save As” dialogue box will appear, prompting you to select the folder 

where you want to save the application or file. Before selecting the “Save” button, select 
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the folder where you want to save the file. Generally, by default: “C:\Download,” is 

chosen. 

 

Step 4: Your file’s download will start. Your web browser will display a progress bar 

that fills up as you download to keep you informed about the download’s progress.  

In the example above, the file will be saved as “F: \ZoomInstaller.exe”. 

Depending on the sort of file you downloaded, what follows next is different. Most of 

the files you download will have one of two extensions.  

▪ EXE files: .exe files means executable files. It is an application that can be executed. 

From there, follow the on-screen directions to install the program on your computer 

and learn how to use it after it’s installed. 

▪ ZIP files: ZIP is a popular file format for compressing and combining files to make 

them download faster. Some versions of Windows (such as XP and ME) can read ZIP 

files without the need for additional software. You’ll need an unzipping application 

to read these ZIP files if you don’t have one. 

 

Guideline for download other files: 

1. On your computer, open Chrome. 

2. Go to the site where you want to download the file. 

3. Save the file: 

▪ Most files: Click the download link. You can also right-click on the file and 

choose Save as. 

▪ Images: Right-click on the image and choose Save Image As. 

▪ Videos: Point to the video. Click Download . If you can't do this action, the 

video's owner or hosting site has prevented downloads. 

▪ PDFs: Right-click on the file and choose Save Link As. 

▪ Web pages: At the top right, click More   More Tools  Save Page As. 

4. If asked, choose where you want to save the file, then click Save. 
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▪ Executable files (.exe, .dll, .bat): If you trust the file, click Save. If you're not 

sure about the contents of the download, click Discard. 

5. When you begin a download, a Download in progress icon  appears on the top 

right next to the address bar. Once the download completes, the Download tray 

opens. 

 

6. To open your file, click Open new . 

▪ You can also click the file to open it. 

 

Tips: 

▪ To show extra actions like Show in Folder , point to the filename. 

▪ If you download a file, or if you’ve recently downloaded a file, the Download 

tray  will appear. Recently downloaded files will appear to the right of the 

address bar. 

▪ To view all downloads if the Download tray  isn't present to the right of the 

address bar, click More   Downloads. 

▪ You can drag a downloaded file to another folder, program, or website. To move 

a downloaded file, in the Download tray  , click the file and drag it to the 

target location. 

 

 

 

2.3 Assessing Media Quality and Relevance 

Not all media elements are created equal. It's important to assess each element for its 

quality and relevance to your digital learning content. 

Work Instructions: 

Step 1: Evaluate the quality of the media element. This includes its resolution, sound or 

image quality, and the clarity of its message. 

Step 2: Assess the relevance of the media element. Does it align with your learning 

objectives and support your content? 

Step 3: Make a decision to include or discard the media element based on your 

assessments. 

3. Legal and Ethical Guidelines for Media Usage 

▪ Understanding Copyrights and Fair Use 

When using media elements in your digital learning content, it's crucial to understand 

the legal and ethical guidelines around copyrights and fair use. 

▪ Citing and Acknowledging Media Sources 

It's important to always cite and acknowledge your media sources. This not only 

respects the original creator's rights but also enhances the credibility of your content. 
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4. Accessibility and Universal Design in Media Selection 

4.1 Principles of Accessible Media 

Accessible media is a crucial component of inclusive digital learning. It ensures that all 

learners, including those with disabilities, can fully engage with your content. 

Work Instructions: 

Step 1: Familiarize yourself with the principles of accessible media. The World Wide Web 

Consortium (W3C) offers comprehensive guidelines known as the Web Content Accessibility 

Guidelines (WCAG) here. 

Step 2: Incorporate accessibility principles in your media selection and content design. This 

can include adding captions to videos, providing text transcripts of audio content, using 

sufficient color contrast, and adding alt text to images. 

Step 3: Regularly test and update your content to ensure it continues to meet accessibility 

standards. 

 

4.2 Inclusive Design in Media Selection 

Inclusive design involves designing your digital learning content to be accessible and usable 

by the widest range of learners possible, irrespective of their abilities, age, or cultural 

backgrounds. 

Work Instructions: 

Step 1: Understand the principles of inclusive design. The Inclusive Design Research Centre 

provides a useful guide (more details follow the link: https://idrc.ocadu.ca/about-the-idrc/). 

Step 2: Choose media that represents diversity and is sensitive to different cultures, abilities, 

and learning preferences. 

Step 3: Seek feedback from a diverse range of learners and use it to refine your content and 

make it more inclusive. 
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5. Accessing OER (Open Educational Resources) 

Open Educational Resources (OER) are teaching, 

learning and research materials in any medium – digital 

or otherwise – that reside in the public domain or have 

been released under an open license that permits no-cost 

access, use, adaptation and redistribution by others with 

no or limited restrictions (According to UNESCO:). 

OERs are free resources that can be used for teaching, 

learning, and assessing. They can include textbooks, 

lesson plans, quizzes, games, simulations, videos, and 

more. 

The 5 Rs of Using OER 

Within the bounds of Creative Commons licensing there are 5 key points to consider when 

using OERs: 

 

Within the bounds of Creative Commons licensing there are 5 key points to consider when 

using OERs: 

1. Reuse - Content can be reused in its unaltered original format - the right to use the 

content in a wide range of ways (e.g., in a class, in a study group, on a website, in a 

video) 

2. Retain - Copies of content can be retained for personal archives or reference - the 

right to make, own, and control copies of the content (e.g., download, duplicate, store, 

and manage) 

3. Revise - Content can be modified or altered to suit specific needs - the right to adapt, 

adjust, modify, or alter the content itself (e.g., translate the content into another 

language) 

4. Remix - Content can be adapted with other similar content to create something new- 

the right to combine the original or revised content with other material to create 

something new (e.g., incorporate the content into a mashup) 

5. Redistribute - Content can be shared with anyone else in its original or altered format 

- the right to share copies of the original content, your revisions, or your remixes with 

others (e.g., give a copy of the content to a friend) 

OERs include a wide range of materials: assessments, assignments, books, case studies, 

courses, journals, primary sources, reference materials, simulations, tutorials, tests, and 

textbooks. 

https://en.unesco.org/themes/building-knowledge-societies/oer
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Benefits, impact of OER: 
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An interesting OER Metaphor 

 

 

Milk Role OERs 

Cow Primary producer/creator Teacher/author 

Calf Primary consumer Enrolled student 

Farmer 
Secondary 

producer/repurposer 

Learning technologist/Course 

leader 

Milk bottlers Primary supplier Learning technologist 

Shop Secondary supplier 
deposit in institutional repository 

or open deposit 
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Human family Secondary consumer 
Teacher within or outside 

institution 

Human family and pets Sharers and re-users Enrolled students of that teacher 

Person with milk, Person 

with cocoa powder, Person 

with sugar – can make 

chocolate 

Exchange and repurposers 
other teachers within or outside 

institution 

Chocolate in shop fridge repository 
deposit in different open 

repositories 

Chocolate eaten re-users/maybe sharing potentially global learners 

Chocolate added to cake 

mixture 
further re-purposing potentially global teachers 
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Self-Check Sheet 3: Collect Media Elements  

 

1. Describe Legal and Ethical Guidelines for Media Usage 

 

 

 

2. What is OER? 

 

 

 

3. Describe The 5 Rs of Using OER 
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Answer Key 3: Collect Media Elements  

 

1. Describe Legal and Ethical Guidelines for Media Usage 

 

Answer:  

▪ Understanding Copyrights and Fair Use 

When using media elements in your digital learning content, it's crucial to understand 

the legal and ethical guidelines around copyrights and fair use. 

▪ Citing and Acknowledging Media Sources 

It's important to always cite and acknowledge your media sources. This not only 

respects the original creator's rights but also enhances the credibility of your content. 

 

2. What is OER? 

Answer: Open Educational Resources (OER) are teaching, learning and research materials 

in any medium – digital or otherwise – that reside in the public domain or have been released 

under an open license that permits no-cost access, use, adaptation and redistribution by 

others with no or limited restrictions (According to UNESCO:). OERs are free resources 

that can be used for teaching, learning, and assessing. They can include textbooks, lesson 

plans, quizzes, games, simulations, videos, and more. 

 

3. Describe The 5 Rs of Using OER  

Answer:  

1. Reuse - Content can be reused in its unaltered original format - the right to use the 

content in a wide range of ways (e.g., in a class, in a study group, on a website, in a 

video) 

2. Retain - Copies of content can be retained for personal archives or reference - the 

right to make, own, and control copies of the content (e.g., download, duplicate, store, 

and manage) 

3. Revise - Content can be modified or altered to suit specific needs - the right to adapt, 

adjust, modify, or alter the content itself (e.g., translate the content into another 

language) 

4. Remix - Content can be adapted with other similar content to create something new- 

the right to combine the original or revised content with other material to create 

something new (e.g., incorporate the content into a mashup) 

5. Redistribute - Content can be shared with anyone else in its original or altered format 

- the right to share copies of the original content, your revisions, or your remixes with 

others (e.g., give a copy of the content to a friend) 
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Task Sheet 3.1: Collect Media Elements  

 

Task Sheet 3.1: Collect Media Elements 

Title: Collect Media Elements 

Performance Objective: By the end of this task, the trainee should be able to: 

1. Source media elements from appropriate sources. 

2. Organize collected media elements for ease of use. 

Policy and Documents Required: 

• Copyright and Fair Use Policies 

• Citing Sources Guidelines 

Tools and Materials Required: 

• Internet access for sourcing media 

• System for organizing media 

Equipment: 

• Laptop or Computer 

• Internet Access 

Steps/Procedures: 

1. Identify Necessary Media Elements: 

• Refer to the lesson plan and content outline to identify the specific types of 

media elements required for the digital learning materials. These may include 

images, videos, audio clips, graphics, or interactive elements. 

2. Source Media from Appropriate Sources: 

• Use various internet resources, textbooks, social media platforms, and Open 

Educational Resources (OER) to source relevant media elements. Ensure that 

all media elements chosen are permitted for use or reuse under copyright law 

and adhere to fair use policies. 

3. Ensure Copyright Compliance and Citation: 

• Verify that all sourced media elements are properly attributed and comply 

with copyright and fair use policies. Provide proper citations for each media 

element used. 

4. Store and Organize Collected Media: 

• Establish a logical and efficient system for storing and organizing the 

collected media elements. Create folders or categories that make it easy to 

access the media during the content development phase. 

5. Review and Quality Check: 

• Review the collected media elements to ensure they meet the required quality 

standards and align with the learning objectives. Discard any media elements 

that may not be suitable for the content. 
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Assessment Method: Evaluation of the trainee's collection of relevant, high-quality media 

that adheres to copyright and citation guidelines. The assessment will also evaluate the 

efficiency and effectiveness of the organization system for media, ensuring ease of access 

during the content development phase. 
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Specification Sheet 3.1 

A. Supplies Documents 

▪ Sample format of a TNA Questionnaire  

▪ Copy of existing Course Accreditation Document or competency standard 

(related to your qualification) 

 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Learning Outcome 4: Prepare Digitally Formatted Contents  

 

Assessment Criteria:  

1. Media elements are organized and appended with content development software as 

per lesson/ session plan. 

2. Proper action verbs are used and maintained during the preparation of the objectives 

of the session / lesson. 

3. Media elements used in digital content are formatted. 

4. Appropriate animation is used to make the presentation attractive and interactive 

5. OER are accessed and used during the content development process if required 

 

Content:  

 

1. Principles of Digitizing Learning Content 

1.1. Digitization Techniques 

1.2. Enhancing Learning Experience through Digital Formats 

2. Selecting Software and Tools for Digital Formatting 

2.1. Overview of Popular Formatting Tools 

2.2. Aligning Tool Selection with Content Requirements 

3. Digitizing Content 

3.1. Step-by-step Process of Digitizing Content 

3.2. Ensuring Quality and Consistency 

4. Enhancing Engagement with Digital Formats 

4.1. Interactive Elements in Digital Content 

4.2. Using Digital Formats for Active Learning 

5. Accessibility in Digital Formats 

5.1. Principles of Digital Accessibility 

5.2. Tools and Techniques for Ensuring Accessibility 

 

Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  
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Methodologies  

▪ Lecture/discussion  

▪ Demonstration/application  

▪ Presentation 

▪ Blended delivery methods  

  

Assessment Methods 

▪ Written test   

▪ Demonstration  

▪ Observation with checklist  

▪ Oral questioning  

▪ Portfolio  
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Learning Experience 4: Prepare Digitally Formatted Contents 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about 

Preparing Digitally 

Formatted Contents. 

1. Instructor will provide the learning materials “Develop 

Digital Learning Materials” 

2. Read the Information 

sheet/s 

2. Information Sheet No: 4 Prepare Digitally Formatted 

Contents 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 4 Prepare Digitally Formatted Contents 

Answer key No. 4 Prepare Digitally Formatted Contents 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:4-1 Prepare Digitally Formatted Contents 

 

Specification Sheet: 4-1 Prepare Digitally Formatted 

Contents 
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Information Sheet 4: Prepare Digitally Formatted Contents  
 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Organize and append Media elements with content development software as per 

lesson/ session plan. 

2. Use and maintain Proper action verbs during the preparation of the objectives 

of the session / lesson. 

3. Format Media elements used in digital content. 

4. Use Appropriate animation to make the presentation attractive and interactive 

5. Access and use OER during the content development process if required 

 

 

1. Principles of Digitizing Learning Content 

▪ Digitization Techniques 

Digitizing learning content is a process that involves 

converting physical or analog educational content into a 

digital format. This can enhance accessibility, interaction, 

and learning experiences for students. 

 

Work Instructions: 

Step 1: Identify the types of content you need to digitize. This could be textbooks, lesson 

plans, images, audio recordings, or videos, among others. 

Step 2: Choose an appropriate digitization technique for each type of content. For instance, 

text can be digitized using Optical Character Recognition (OCR) software, images using 

scanners, and audio or video using recording and editing software. 

Step 3: Use the selected technique to digitize your content. Follow best practices for 

digitization to ensure high-quality results.  

 

▪ Enhancing Learning Experience through Digital Formats 

Digital formats can greatly enhance learning experiences by making content more 

engaging, interactive, and accessible. 

Work Instructions: 

Step 1: Identify ways to enhance your content through digital formats. For example, you 

can incorporate multimedia elements, interactive quizzes, or virtual simulations. 

Step 2: Implement these enhancements using appropriate software or tools. 

Step 3: Test the enhanced content with learners to ensure that it improves their learning 

experience. 
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2. Selecting Software and Tools for Digital Formatting 

There are numerous tools available for digital formatting, each with different features and 

suited to different content types. Research popular formatting tools. Some examples include 

Microsoft Word for text, Adobe Photoshop for images, and Adobe Premiere Pro for video. 

Compare the features of these tools. Consider their ease of use, capabilities, cost, and 

compatibility with your content and learning platform. Choose the tool or tools that best 

meet your needs. The software and tools you select should be capable of fulfilling your 

content requirements. 

3. Digitizing Content 

3.1. Step-by-step Process of Digitizing Content 

Work Instructions: 

Step 1: Organize your content. Have all physical or analog content ready for digitization. 

Step 2: Choose the appropriate tool or software for digitization. 

Step 3: Digitize your content. Ensure you maintain the quality and integrity of the original 

content during the process. 

Step 4: Review and refine the digitized content. Check for errors or omissions and correct 

them. 

 

Create Digital Content using Microsoft PowerPoint: 

Introduction to Presentation application: 

A presentation package is a software program that provides the resources necessary to give a 

professional presentation for meetings, lectures, speeches or other similar situations. 

The most prominent example of presentation software is Microsoft PowerPoint. Other 

examples include Apple Keynote, OpenOffice Impress, Corel Presentations, Adobe 

Persuasion, Flowboard, Kingsoft Presentation and Prezi. 

Here we discuss about Microsoft PowerPoint- 

PowerPoint is computer application created by Microsoft which allows the user to create slides 

with recordings, narrations, transitions and other features in order to present information. 

PowerPoint is a presentation software made by Microsoft. 

A PowerPoint presentation is a presentation created using Microsoft PowerPoint software. The 

presentation is a collection of individual slides that contain information on a topic. PowerPoint 

presentations are commonly used in business meetings and for training and educational 

purposes. 
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Run PowerPoint  

 

 

 

PowerPoint Layout: 

 

 

 

Insert New Slide: 

Here you will learn how to insert a new slide in PowerPoint. When you create a new 

presentation, PowerPoint gives you one default slide that contains a “Title Slide” layout. You 

can click into the placeholders shown in the title slide. Then click the “New Slide” button in 

the “Slides” button group. 

Way 1 – From Start Menu 

Step 1 – The most common way to open 

PowerPoint is with the help of the Start menu. Click 

on the Start button which is in the leftmost corner 

of the taskbar. 

Step 2 – Locate Microsoft Office in the M alphabet 

section and click on it to expand. 

Step 3 – Find PowerPoint in the list and then click 

on it. 
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Insert a New Slide in PowerPoint:  

1. To insert a new slide that contains a 
“Title and Content” slide layout, click 

the “Home” tab in the Ribbon. 

2. Then click the “New Slide” button in 

the “Slides” button group 

 

 

Save Presentation File: 

 

1. Select File > Save as (or Save a 

Copy). 
2. Click browse options. 

3. Browse to the folder where you want 

to save your presentation. 

4. In the File name box, type a name for 
your presentation. 

5. Under Save as type, select 

PowerPoint Presentation (pptx). 
6. Click save button 

 

 

Insert Layout in Slide: 

Apply a slide layout. You choose a layout from a menu in PowerPoint, then insert your 

words and graphics. The predefined layouts include a Title slide to begin with, a general 

Title and Content layout, a side-by-side Comparison layout, and a Picture-with-Caption 

layout 

 

Insert a Slide layout in PowerPoint:  

1. To insert a slide layout that contains 
layout button, click the “Home” tab 

in the Ribbon. 

2. Then click the “layout” button in the 

“Slides” button group 
3. Select required layout. 
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Use of Shape: 

PowerPoint has many useful shapes ready to insert into your slides. Basic shapes such as 

lines, bubbles, curves, and more can add a necessary visual element to your document. 

 

To insert a shape: 

1. Select the Insert tab. 
2. Click the Shape command. 

3. Left-click a shape from the menu. 

Your cursor is now a cross shape. 
4. Left-click your mouse and while 

holding it down, drag your mouse 

until the shape is the desired size. 

5. Release the mouse button. 

Use of Quick Style:  

A Quick Style set contains the basic styles that you need to build a document. However, you 

may want to add a custom style. Select the text that you want to format as a new style. For 

example, perhaps you want text that contains certain information about your business to 

always appear as bold and red in your document. 

 

1. Apply or change a Quick Style set. 

On the home tab, click the quick 

part bottom 

2. Then choose a style set such as 
Basic or Casual. On the Home tab, 

the options in the Styles group 

change to reflect the Quick Style 

set that you clicked. 

 

 

Use of Table in Slide: 

When presenting ideas that include references to data, it can be helpful to make the point 

using a table. These visual methods can make the point much stronger than simply describing 

the data. 
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Create and format a table in PowerPoint 

1. Select the slide that you want to 
add a table to. 

2. On the Insert tab, select Table. 

3. In the Insert Table dialog box, do 
one of the following: Use the 

mouse to select the number of rows 

and columns that you want. 

4. To add text to the table cells, click 

a cell, and then enter your text. 

 

Insert Picture: 

Adding picture scan make your presentations more interesting and engaging. You can insert 

a picture from a file on your computer onto any slide. PowerPoint even includes tools for 

finding online pictures and adding screenshots to your presentation. 
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To insert a picture from a file: 

1. Place your insertion point where you want the image to appear. 

2. Select the Insert tab. 

3. Click the Picture command in the Illustrations group. The Insert Picture dialog box appears. 

4. Select the desired image file, then click Insert to add it to your document. Selecting an image 

file. 

Use of SmartArt: 

A SmartArt graphic is a visual representation of information and ideas, and a chart is a visual 

illustration of numeric values or data. Basically, SmartArt graphics are designed for text and 

charts are designed for numbers. Use the information below to decide when to use a SmartArt 

graphic and when to use a chart. 

Use of Chart:  

To insert a SmartArt graphic: 

1. Select the slide where you want the 

SmartArt graphic to appear. 

2. From the Insert tab, select the 
SmartArt command in the 

Illustrations group. Clicking the 

SmartArt command. 
3. A dialog box will appear. 

4. The SmartArt graphic will appear on 

the current slide. 

Chart refers to a graphical representation of data. Charts are used to visually communicate 

information, trends, and patterns present in your data. They are often more comprehensible 

than raw data in tables or spreadsheets, making it easier for readers to understand and analyze 

the information.  

  

1. In Word, click where you want to 

insert the chart. 

2. On the Insert tab, in the 

Illustrations group, click Chart. 

3. In the Insert Chart dialog box, 

click a chart, and then click OK. 

4. Enter your data into the 

spreadsheet that automatically 

opens with the chart. 
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Use of Rectangle: 

Select the Insert tab, then click the Shapes command in the Illustrations group. A drop-down 

menu of shapes will appear. Select the rectangle shape. Click and drag in the desired location 

to add the shape to the slide. 

 

1. Select Insert tab. 

2. Click rectangle from shapes 

command. 
3. Click and drag in the desired 

location to add the shape to the 

slide. 

 

 

 

 

Use of hyperlink: 

In POWERPOINT 2016, a HYPERLINK is simply a bit of text or a graphic image that you 

can click when viewing a slide to summon another slide, another presentation. 

 

To insert a hyperlink to 

another slide: 

1. Right-click the selected 

text or image, then click 
Hyperlink. 

2. The Insert Hyperlink 

dialog box will appear. 
3. On the left side of the 

dialog box, click Place in 

this Document. 
4. A list of other slides in 

your presentation will 

appear. 

5. Click OK 
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Use of Action Button: 

Action buttons are built-in shapes you can add to a presentation and set to link to another 

slide, play a sound, or perform a similar action. When someone clicks or hovers over the 

button, the selected action will occur. Action buttons can do many of the same things as 

hyperlinks. 

 

To insert an action button on 

one slide: 
1. Click the Insert tab. 

2. Click the Shapes 

command in the 
Illustrations group. 

3. Select the desired action 

button. 

4. Insert the button onto the 
slide by clicking the 

desired location.  

5. Select the Mouse Click or 

Mouse Over tab. 

 

 

 

Use of Recording Option: 

The Recording tab introduced in PowerPoint 2016 gives you this ability and goes even 

further with more interactive elements—like quizzes—to include in a presentation. Your 

interactive video can contain: Audio narration. 

 

Take a screen recording 

1. As for screen capture. 

2. Choose Insert, Screen 

Recording from the Media 
group. 

3. To record part of the 

screen, click the Select 
Area button and drag across 

the area you want to record. 

4. Click Record. 

5. Press Windows button + 
Shift + Q and the video 

appears on your current 

slide 
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Use of Built-in Slide Template: 

A PowerPoint template is a pattern or blueprint of a slide or group of slides that you save as 

a .potx file. Templates can contain layouts, colors, fonts, effects, background styles, and even 

content. You can create your own custom templates and store them, reuse them, and share 

them with others. 

 

 

Applying themes 

1. Select the Design tab on the 

Ribbon, then locate the Themes 

group. Each image represents a 

theme. 
2. Click the More drop-down 

arrow to see all available 

themes. 
3. Select the desired theme. 

4. The theme will be applied to the 

entire presentation. To apply a 

different theme, simply select it 

from the Design tab. 

 

Use of Slide Transition: 

Slide transitions are the effects that take place when one slide gives way to the next one in 

the presentation, like Roll down from top or Fly in from left. They add dynamic flair to a 

slideshow, smoothing the transition between slides. You can add transitions while in Slide 

Sorter view or in Normal view. 

 

To apply a transition: 

1. Select the desired slide from 

the Slide Navigation pane. 

2. Click the Transitions tab, 
then locate the Transition to 

This Slide group. 

3. Click the More drop-down 

arrow to display all 
transitions. 

4. Click a transition to apply it 

to the selected slide. 
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Set Timing in Slide: 

Specify a TIME to advance to the next SLIDE. Select the SLIDE that you want to SET the 

TIMING for. On the Transitions tab, in the TIMING group, under Advance SLIDE, do one 

of the following: To make the SLIDE advance to the next SLIDE when you click the mouse, 

select the On Mouse Click check box. 

 

Specify a time to advance to the 

next slide 

1. Select the slide that you 

want to set the timing for. 

2. On the Transitions tab, in 

the Timing group, under 
Advance Slide, do one of 

the following: To make the 

slide advance to the next 
slide when you click the 

mouse, select the On Mouse 

Click check box. 

 

Set Animation in Slide: 

PowerPoint animation is a form of animation which uses Microsoft PowerPoint and similar 

programs to create a game or movie. The artwork is generally created using PowerPoint's 

AutoShape features, and then animated slide-by-slide or by using Custom Animation. 

 

To apply a custom animation 

effect in Office PowerPoint, do the 

following: 

1. Select the text or object that 
you want to animate. 

2. On the Animations tab, in 

the Animations group, click 
Custom Animation. 

3. In the Custom Animation 

task pane, click Add Effect, 

and then do one or more. 
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Control Animation: 

Slide transition animation in PowerPoint is the animation that occurs when you advance from 

slide to slide within the presentation. You have many options for controlling the effects of 

the slide transition animation in PowerPoint. 

 

Open the Animation Pane 

1. Select the object on the 

slide that you want to 

animate. 
2. On the Animations tab, 

click Animation Pane. 

3. Click Add Animation, and 

pick an animation effect. 
4. To apply additional 

animation effects to the 

same object, select it, click 
Add Animation and pick 

another animation effect. 

 

 

Use of Slide Show: 

A slide show is a presentation of a series of still images on a projection screen or electronic 

display device, typically in a prearranged sequence. The changes may be automatic and at 

regular intervals or they may be manually controlled by a presenter or the viewer. 

 

To set up a PowerPoint 

presentation to run 

automatically, do the following: 

1. On the Slide Show tab, 

click Set Up Slide Show. 
2. Under Show type, pick one 

of the following: To allow 

the people watching your 
slide show to have control 

over when they advance the 

slides, select Presented by a 
speaker  

3. To allow automatically play 

slide show, select loop 

continuously until Esc. 
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Motion Paths.  

A motion path moves an item, like a picture, on a line you specify. So, you use a motion path 

to move something in a very specific way on a slide. You can also combine motion paths 

with other effects. 

 

Add a motion path to an object 

1. Click the object you want to 

animate. 

2. On the Animations tab, 
click Add Animation. 

3. Scroll down to Motion 

Paths, and pick one. Tip: If 

you choose the Custom 
path option, you will draw 

the path that you want the 

object to take. To stop 
drawing a custom path, 

press Esc. 

 

Use of Slide Master: 

In Microsoft PowerPoint, the Slide Master is the top slide that controls all information about 

the theme, layout, background, color, fonts, and positioning of all slides. Using the Slide 

Master can be an easy way to adjust the look of an existing theme or make overall changes 

to all slides in your presentation. 

 

1. Select the View tab, then 

click the Slide Master 

command. 

2. The presentation will 
switch to Slide Master 

view, and the Slide Master 

tab will be selected on the 
Ribbon. 

3. In the left navigation pane, 

scroll up and select the 

slide. This is the slide 
master. 

4. Create your design as 

required. 
5. Close slide master view 

6. Then select new slide. 
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Make video Tutorial for YouTube 

1. Open Video Editing Software (Camtasia20) 

 

2. Click on “New project” 

 

3. Click on “Import media” to insert raw footage (which is recorded by camera) 
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4. Drag the raw footage into Track 

 

 

5. To Add text click on “Annotation” and select text style. 
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6. For Adjusting Font size, color, and align use “properties panel”.  
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7. Type the script in the text box and adjust with footage voice. 

 

 

8. Now “export” the file .mp4 format for final video to use YouTube channel  

 

 

4. Enhancing Engagement with Digital Formats 

▪ Interactive Elements in Digital Content 

Incorporating interactive elements in your digital content can increase student engagement 

and participation. Identify places in your content where interactive elements could be 

beneficial. This could be a complex concept that can be better explained with an interactive 

diagram, or a topic that can be reinforced with a quiz. 

▪ Use Digital Formats for Active Learning 

Digital formats can support active learning, where students are actively involved in their 

own learning process. This could be an exercise that students can do on their own, or a 

discussion that they can participate in. Use the features of your digital format to support 

these active learning activities. For example, you could use interactive elements, 

collaborative tools, or multimedia content. 
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5. Accessibility in Digital Formats 

▪ Principles of Digital Accessibility 

Digital accessibility is crucial to ensure that all learners, including those with disabilities, 

can access and benefit from your content. Familiarize yourself with the principles of digital 

accessibility. The Web Content Accessibility Guidelines (WCAG) provide a 

comprehensive guide to these principles. Apply these principles to your content. This could 

involve using alt text for images, captions for videos, or keyboard navigation for interactive 

elements. 

▪ Tools and Techniques for Ensuring Accessibility 

There are various tools and techniques you can use to ensure your digital content is 

accessible. Identify the accessibility features of your chosen digital tools. Many tools have 

built-in features that support accessibility, such as alt text for images in Microsoft Word. 
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Self-Check Sheet 4: Prepare Digitally Formatted Contents  

 

1. Describe Legal and Ethical Guidelines for Media Usage 

 

 

 

2. What is OER? 

 

 

 

3. Describe The 5 Rs of Using OER 
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Answer Key 4: Prepare Digitally Formatted Contents  

 

1. What is digitization of learning content? 

Answer: Digitizing learning content is a process that involves converting physical or analog 

educational content into a digital format. This can enhance accessibility, interaction, and 

learning experiences for students. 

 

2. What are the principles of digital accessibility? 

Answer: The principles of digital accessibility include providing alternative text for images, 

closed captions for videos, keyboard navigation for interactive elements, and ensuring that 

all content can be accessed and understood by assistive technologies. 

 

3. What are some common accessibility features of digital tools? 

Answer: Some common accessibility features of digital tools include alt text for images, 

closed captions for videos, keyboard navigation, and text resizing. These features can help 

make content more accessible to learners with disabilities. 
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Task Sheet 4.1: Format Media Elements  

 

Task Sheet 4.1: Format Media Elements 

Title: Format Media Elements 

Performance Objective: By the end of this task, the trainee should be able to: 

1. Format media elements to align with the digital content. 

2. Ensure media elements are suitable for the chosen presentation method. 

Policy and Documents Required: 

• Media formatting guides 

Tools and Materials Required: 

• Media editing software (e.g., Adobe Photoshop for images, Adobe Premiere Pro for 

videos) 

• Document formatting software (e.g., Microsoft Word for text) 

Equipment: 

• Laptop or Computer 

• Media editing software 

• Document formatting software 

Steps/Procedures: 

1. Review Selected Presentation Method: 

• Review the chosen presentation method (e.g., PowerPoint, video, audio, web-

based platform) to understand the specific formatting requirements for each 

media element. Consider aspects like aspect ratios, resolution, file formats, 

and compatibility with the chosen presentation medium. 

2. Open Media Elements in Editing Software: 

• Open each media element in the appropriate editing software that corresponds 

to its type (e.g., images in Adobe Photoshop, videos in Adobe Premiere Pro, 

text in Microsoft Word). 

3. Format Media Elements as Needed: 

• Format the media elements to meet the requirements of the selected 

presentation method. This may involve various adjustments such as: 

• Resizing images to fit the slide dimensions or video frame. 

• Adjusting video resolution and aspect ratio to suit the display 

platform. 

• Setting appropriate audio levels and ensuring clear audio quality. 

• Styling text with appropriate fonts, sizes, and colors for readability. 

4. Save Formatted Media Elements: 
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• Save the formatted media elements in appropriate formats that are compatible 

with the digital content development software or tools being used. Ensure the 

media elements are optimized for smooth integration and playback. 

5. Review and Quality Check: 

• Review the formatted media elements to ensure they align with the content, 

meet the requirements of the selected presentation method, and maintain 

high-quality standards. 

Assessment Method: Assessment of the trainee's ability to format media elements according 

to the requirements of the selected presentation method. The assessment will evaluate the 

trainee's proficiency in formatting images, videos, audio, and text to ensure they are suitable 

for the chosen presentation medium and aligned with the digital content. 
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Specification Sheet 4.1: 

A. Policy and documents required: 

▪ Bangladesh National Qualifications Framework (BNQF) 

▪ Competency Standard or “Training Package” 

 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

▪ Interview questionnaire 

▪ Observation checklist 

 

C. Equipment: 

▪ Laptop/Computer 
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Learning Outcome 5: Test Digitally Formatted Learning 

Contents 
 

Assessment Criteria:  

1. Test criteria and instruments are developed in line with learning material specification. 

2. Test sites and reviewers are identified in line with established target users 

3. Testing of learning contents are undertaken in line with plan 

4. Feedback and suggestions are addressed in line with plan and development cycle. 

5. Developed digital contents are preserved in appropriate storage 

Content:  

1. Designing Content for Various Devices and Platforms 

1.1. Responsive Design Principles 

1.2. Testing and Adjusting Content for Different Devices 

2. Understanding the Importance of Testing 

3. Testing All Functional Elements 

4. Ensuring Responsiveness 

5. Accessibility Testing for Inclusivity 

5.1. Guidelines for Accessible Content 

5.2. Tools for Accessibility Testing 

6. User Experience Testing 

6.1. Gathering User Feedback 

6.2. Incorporating Feedback into Design Changes 
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Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  

 

 Methodologies  

▪ Lecture/discussion  

▪ Demonstration/application  

▪ Presentation 

▪ Blended delivery methods  

  

Assessment Methods 

▪ Written test   

▪ Demonstration  

▪ Observation with checklist  

▪ Oral questioning  

▪ Portfolio  
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Learning Experience 5: Test Digitally Formatted Learning Contents 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Test 

Digitally Formatted 

Learning Contents. 

1. Instructor will provide the learning materials 

“Develop Digital Learning Materials” 

2. Read the Information 

sheet/s 

2. Information Sheet No:5-1 Test Digitally Formatted 

Learning Contents 

3. Complete the Self Checks 

& Check answer sheets. 

3. Self-Check/s 

Self-Check No: 5 Test Digitally Formatted Learning 

Contents 

Answer key No. 5 Test Digitally Formatted Learning 

Contents 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No: 5-1 Test Digitally Formatted 

Learning Contents 

 

Specification Sheet: 5-1 Test Digitally Formatted Learning 

Contents 
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Information Sheet 5: Test Digitally Formatted Learning Contents  

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Develop Test criteria and instruments in line with learning material specification. 

2. Identify Test sites and reviewers in line with established target users 

3. Undertake Testing of learning contents in line with plan 

4. Address Feedback and suggestions in line with plan and development cycle. 

5. Preserve developed digital contents in appropriate storage 

 

Content: 

1. Designing Content for Various Devices and Platforms 

▪ Responsive Design Principles 

Responsive design ensures that your content looks good 

and functions well on various devices and screen sizes. It 

ensures that design and development should respond to 

the user's behavior and environment based on screen size, 

platform and orientation.  

Work Instructions: 

Step 1: Familiarize yourself with the principles of responsive design. This involves 

designing your content to be flexible and adapt to different screen sizes. 

Step 2: Implement these principles when designing your content. Many digital tools 

support responsive design and allow you to preview how your content will look on 

different devices. 

Step 3: Test your content on various devices to ensure it adapts properly and provides 

a good user experience on all of them. 

▪ Testing and Adjusting Content for Different Devices 

It’s important to test your content on different devices and adjust it as necessary to ensure 

a good learning experience for all students, regardless of the device they are using. 
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2. Understanding the Importance of Testing 

Testing is a crucial step in the development of digital learning 

content. It helps identify issues or shortcomings in the content 

and ensure that the learning experience meets the intended 

objectives. Testing determines whether your target audience 

can find, understand, and comprehend your content. 

3. Testing All Functional Elements 

It is important to test all functional elements in your digital content to ensure they work as 

expected and enhance the learning experience. 

4. Ensuring Responsiveness 

Responsiveness is a key aspect of digital content, ensuring that it works well on various 

devices and screen sizes. 

5. Accessibility Testing for Inclusivity 

▪ Guidelines for Accessible Content 

Making your content accessible ensures that all learners, including those with disabilities, 

can access and benefit from it. The Web Content Accessibility Guidelines (WCAG) 

provide a comprehensive guide to these principles. 

▪ Tools for Accessibility Testing 

Various tools can help you test the accessibility of your content. Identify suitable tools for 

accessibility testing. This could include screen readers, color contrast analyzers, and 

accessibility checkers integrated into content creation tools. 

6. User Experience Testing 

▪ Gathering User Feedback 

User feedback can provide valuable insights into the user experience and help identify 

areas for improvement. 

▪ Incorporating Feedback into Design Changes 

User feedback should be used to inform design changes and improve the overall user 

experience. 

Sample check list for test Digitally Formatted Learning Contents 

SL 

No. 
Testing Question 

Please place a tick in the appropriate column 

Strongly 

Agree 
Agree Neutral Disagree 

Strongly 

Disagree 

FUNCTIONALITY TESTING:    
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01 ▪ Interactive elements 

(buttons, links, forms) 

work as intended. 

 

 

   

02 ▪ Media players (video, 

audio) function properly. 

 
 

   

03 ▪ Quizzes, assessments, and 

simulations operate 

correctly. 

 

 

   

04 ▪ Navigation within the 

content is smooth and 

intuitive. 

 

 

   

COMPATIBILITY TESTING:    

05 ▪ Content displays and 

functions correctly across 

different devices (desktop, 

mobile, tablets). 

 

 

   

06 ▪ Compatibility across 

various web browsers 

(Chrome, Firefox, Safari, 

Edge). 

 

 

   

07 ▪ Responsive design adapts 

well to different screen 

sizes and resolutions. 

 

 

   

USABILITY TESTING:    

08 ▪ Clear and logical content 

structure and organization. 

 
 

   

09 ▪ Intuitive user interface 

with easy-to-understand 

instructions. 

 

 

   

10 ▪ Adequate navigation 

options and menu 

structure. 
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11 ▪ Proper labeling and 

positioning of interactive 

elements. 

 

 

   

ACCESSIBILITY TESTING:    

12 ▪ Compliance with 

accessibility standards 

(WCAG 2.1, Section 508). 

 

 

   

13 ▪ Alternative text for 

images. 

 
 

   

14 ▪ Keyboard accessibility for 

navigation and interaction. 

 
 

   

15 ▪ Sufficient color contrast 

for readability. 

 
 

   

INTERACTIVITY TESTING:    

16 ▪ Interactive elements 

provide appropriate 

feedback. 

 

 

   

17 ▪ Assessments and quizzes 

provide accurate scoring 

and feedback. 

 

 

   

18 ▪ Simulations and 

interactive exercises 

perform as expected. 

 

 

   

19 ▪ User inputs are captured 

accurately. 

 
 

   

 

RECOMMENDATIONS: 
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Self-Check Sheet 5: Test Digitally Formatted Learning Contents  

 

1. What is Responsive Design Principles? 

 

 

 

2. Why is testing important in the development of digital learning content? 

 

 

 

3. What is the purpose of gathering user feedback in user experience testing? 
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Answer Key 5: Test Digitally Formatted Learning Contents  

 

1. What is Responsive Design Principles? 

Answer: Responsive design ensures that your content looks good and functions well on 

various devices and screen sizes. It ensures that design and development should respond to 

the user's behavior and environment based on screen size, platform and orientation. 

 

2. Why is testing important in the development of digital learning content? 

Answer: Testing is important because it helps identify issues or shortcomings in the content 

and ensures that the learning experience meets the intended objectives. It also helps to 

determine whether the target audience can find, understand, and comprehend the content. 

 

3. What is the purpose of gathering user feedback in user experience testing? 

Answer: The purpose of gathering user feedback is to provide valuable insights into the 

user experience and identify areas for improvement. 

 

4. How should user feedback be used in design changes? 

Answer: User feedback should be used to inform design changes and improve the overall 

user experience. By incorporating user feedback into design changes, you can create a more 

user-friendly and effective learning experience. 
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Task Sheet 5.1: Develop Test Criteria and Instruments  
 

Task Sheet 5.1: Develop Test Criteria and Instruments 

Title: Develop Test Criteria and Instruments 

Performance Objective: At the end of this task, the trainee should be able to: 

1. Develop appropriate test criteria to assess the quality and effectiveness of the digital 

learning content. 

2. Develop instruments to facilitate the testing process, such as questionnaires or 

feedback forms. 

Policy and Documents Required: 

• Quality assurance guidelines 

• Testing procedures 

Tools and Materials Required: 

• Office Stationeries 

• Digital Assessment Tools like Google Forms, SurveyMonkey 

Equipment: 

• Laptop/Computer 

Steps/Procedures: 

1. Identify Lesson Objectives and Content: 

• Review the lesson objectives and content to be covered in the digital learning material. 

Understand the learning outcomes and specific areas that need to be evaluated. 

2. Develop Test Criteria: 

• Based on the lesson objectives and content, develop a set of test criteria that can be 

used to assess the quality and effectiveness of the digital learning content. These 

criteria should be clear, specific, and aligned with the desired learning outcomes. 

3. Create Measurable Indicators: 

• For each test criterion, create clear and measurable indicators that will serve as 

evidence of the content's effectiveness. Ensure that the indicators can be observed or 

measured objectively. 

4. Develop Testing Instruments: 

• Develop instruments, such as questionnaires or feedback forms, that can be used to 

gather data for each of the test criteria. These instruments should capture relevant 

information from the learners or reviewers to evaluate the content. 

5. Ensure Clarity and Ease of Use: 

• Review the testing instruments to ensure they are clear, easy to understand, and user-

friendly. Avoid ambiguous questions or instructions that could lead to inconsistent or 

unreliable responses. 

6. Test the Instruments: 



 

113 

 

• Conduct a pilot test of the developed instruments to identify any issues or areas for 

improvement. Make necessary adjustments based on the feedback received. 

7. Finalize Test Criteria and Instruments: 

• Finalize the test criteria and instruments after incorporating the improvements 

identified during the pilot testing. 

Assessment Method: Assessment of the trainee's ability to develop suitable test criteria and 

instruments for assessing digital learning content. The assessment will evaluate the clarity, 

relevance, and effectiveness of the test criteria in evaluating the quality and effectiveness of 

the digital learning material. The developed testing instruments will also be assessed for 

clarity, ease of use, and appropriateness for gathering the necessary data. 

 

  



 

114 

 

Specification Sheet 5.1: Develop Test Criteria and Instruments  

A. Policy and documents required: 

▪ Bangladesh National Qualifications Framework (BNQF) 

▪ Competency Standard or “Training Package” 

 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

▪ Interview questionnaire 

▪ Checklists 

 

C. Equipment: 

▪ Laptop/Computer 
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Task Sheet 5.2: Conduct Testing and Address Feedback 

Task Sheet 5.2: Conduct Testing and Address Feedback 

Title: Conduct Testing and Address Feedback 

Performance Objective: By the end of this task, the trainee should be able to: 

1. Conduct testing of the digital learning content using the developed test criteria and 

instruments. 

2. Collect and analyze feedback from test users. 

3. Make necessary revisions to the digital content based on the feedback received. 

Policy and Documents Required: 

• Quality assurance guidelines 

• Testing procedures 

• Feedback and revision procedures 

Tools and Materials Required: 

• Test criteria and instruments 

• Digital feedback tools 

Equipment: 

• Laptop/Computer 

Steps/Procedures: 

1. Conduct Testing: 

• Use the developed test criteria and instruments to conduct testing of the digital 

learning content. This can be done through pilot tests with a small group of learners 

or reviewers. Ensure that the testing process is well-organized and that data is 

collected systematically. 

2. Collect Feedback: 

• Use digital feedback tools or other appropriate methods to collect feedback from the 

test users. Encourage honest and constructive feedback to identify strengths and 

areas for improvement in the content. 

3. Analyze Feedback: 

• Analyze the feedback collected to identify common themes, patterns, and specific 

issues mentioned by the test users. Categorize the feedback based on its significance 

and relevance to the learning objectives. 

4. Revise Digital Content: 

• Based on the feedback received, make necessary revisions to the digital learning 

content. Address identified issues, clarify confusing points, and improve areas that 

require enhancement. 

5. Re-Test Revised Content: 

• After making the revisions, re-test the digital content using the same test criteria and 

instruments. Ensure that the changes have effectively addressed the feedback and 

improved the content. 
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6. Document Revisions: 

• Document all the revisions made to the digital content, along with the reasons for 

the changes. This documentation will be useful for future reference and quality 

assurance purposes. 

Assessment Method: Assessment of the trainee's ability to conduct effective testing, analyze 

feedback, and make necessary revisions to the digital content. The assessment will evaluate 

the trainee's proficiency in using the developed test criteria and instruments, analyzing 

feedback from test users, and implementing improvements to the digital content based on 

the feedback received. 
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Specification Sheet 5.2 

D. Policy and documents required: 

▪ Bangladesh National Qualifications Framework (BNQF) 

▪ Competency Standard or “Training Package” 

 

E. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

▪ Interview questionnaire 

▪ Checklists 

 

F. Equipment: 

▪ Laptop/Computer 
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Learning Outcome 6: Upload and Use Digital Contents 
 

Assessment Criteria:  

1. Appropriate online media is selected for uploading digital contents 

2. Digital content uploading formalities are done 

3. Digital contents are uploaded in online media for users 

 

Content:  

1. Platforms for publishing learning materials 

2. Uploading Digital Content 

2.1 Procedures of sign-in/registration on Publishing Platform 

2.2 Process of Content Uploading/Sharing 

2.3 Necessary steps to check the published Contents. 

 

 

Resources Required/ Conditions: 

The trainees must be provided with the following: 

▪ Handouts or reference materials/books/ CBLMs on the above stated 

contents  

▪ PCs/printers or laptop/printer with internet access  

▪ Digital projector and Screen  

▪ Bond paper  

▪ Ball pens/pencils and other office supplies and materials  

▪ Relevant learning materials  

▪ Workplace or simulated environment  

 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Blended delivery methods  

  

Assessment Methods 

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Learning Experience 6: Upload and Use Digital Contents 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning 

Steps 

Resources specific instructions 

1. Student will ask the 

instructor about 

uploading and using 

Digital Content. 

1. Instructor will provide the learning materials “Develop 

Digital Learning Materials” 

2. Read the Information 

sheet/s 

2. Information Sheet No:6-1 Upload and Use Digital 

Contents 

3. Complete the Self 

Checks & Check 

answer sheets. 

3. Self-Check/s 

Self-Check No: 6 Upload and Use Digital Contents 

Answer key No. 6 Upload and Use Digital Contents 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:6-1 Upload and Use Digital Contents 

Specification Sheet: 6-1 Upload and Use Digital Contents 
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Information Sheet 6: Upload and Use Digital Contents 

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Select Appropriate online media for uploading digital contents 

2. Ensure Digital content uploading formalities  

3. Upload Digital contents in online media for users 

 

Content: 

 

1. Platforms for Publishing Learning Materials 

There are several platforms available for publishing digital learning materials. Each 

platform comes with its unique features and functionalities. Here are a few prominent ones: 

• Google Drive: Google's cloud storage service that allows you to store, share, and 

collaborate on files and folders from any mobile device, tablet, or computer. 

• Dropbox: A file hosting service providing personal cloud, file synchronization, 

cloud storage, and client software. 

• Amazon S3 (Simple Storage Service): An object storage service that offers 

industry-leading scalability, data availability, security, and performance. 

• Microsoft OneDrive: Microsoft's storage service for hosting files in the "cloud". 

It's available for free to all owners of a Microsoft account. 

• Box: A cloud content management and file sharing service for businesses, offering 

secure, scalable content-sharing that both users and IT love and adopt. 

 

 

2. Uploading Digital Content 

2.1. Procedures of Sign-In/Registration on the Publishing Platform: 

Depending on the chosen platform, the steps may vary slightly, but they generally 

include: 

▪ Navigate to the platform's website: Open a web browser and type in the URL 

of the service you wish to use. 

▪ Create an account or sign-in: If you're new to the platform, you'll have to create 

an account by providing necessary details such as email address and password. If 

you already have an account, just log in with your credentials. 

 

2.2. Process of Content Uploading/Sharing: 

Let's consider Google Drive as an example: 

▪ Navigate to Google Drive: Once logged in, you'll be directed to your Drive. 

On your computer, you can upload from drive.google.com or your desktop. You 

can upload files into private or shared folders. 

1. On your computer, go to drive.google.com. 

2. At the top left, click New   File Upload or Folder Upload. 

https://drive.google.com/
https://drive.google.com/
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3. Choose the file or folder you want to upload. 

 

Drag files into Google Drive 

1. On your computer, go to drive.google.com. 

2. Open or create a folder. 

3. To upload files and folders, drag them into the Google Drive folder. 

 

 

▪ Upload Files/Folders: Click on the "+ New" button on the left side of the page, 

then select either "File upload" or "Folder upload". Navigate through your files, 

select what you want to upload, and click "Open". 

 

▪ Share files/folders: Right-click on the uploaded file/folder and select "Share". 

You can then add the email addresses of people you want to share the file/folder 

with, or you can generate a link that you can send to them. 

 

 

 

https://drive.google.com/
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2.3. Necessary Steps to Check the Published Contents: 

Once your files are uploaded, it is important to check if the uploading process was 

successful and if the content appears as expected. 

▪ Check the upload status: Most platforms will notify you once the upload is 

complete. 

▪ Open the file: Open the uploaded file to ensure it appears as expected. 

▪ Test the sharing settings: If you've shared the content, check if the 

recipients can access it properly. You may do this by either signing in from 

a different account or asking a recipient to confirm. 
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Self-Check Sheet 6: Upload and Use Digital Contents  

 

1. What is Google Drive? 

 

 

 

2. Why is testing important in the development of digital learning content? 

 

 

 

3. What is the purpose of gathering user feedback in user experience testing? 
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Answer Key 6: Upload and Use Digital Contents  

 

1. What is Google Drive? 

Answer: Google drive is Google’s cloud storage service that allows you to store, share, and 

collaborate on files and folders from any mobile device, tablet, or computer. 

 

2. List 5 Platforms for Publishing Learning Materials 

Answer: Some Platforms for Publishing Learning Materials are: 

▪ Google Drive 

▪ Dropbox 

▪ Amazon S3 (Simple Storage Service) 

▪ Microsoft OneDrive 

▪ Box 

 

 

3. How to upload/share digital content in google drive? 

Answer: Process of Content Uploading/Sharing: 

▪ Navigate to Google Drive: Once logged in, you'll be directed to your Drive. 

On your computer, you can upload from drive.google.com or your desktop. You 

can upload files into private or shared folders. 

4. On your computer, go to drive.google.com. 

5. At the top left, click New   File Upload or Folder Upload. 

 

https://drive.google.com/
https://drive.google.com/
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6. Choose the file or folder you want to upload. 

 

Drag files into Google Drive 

1. On your computer, go to drive.google.com. 

2. Open or create a folder. 

3. To upload files and folders, drag them into the Google Drive folder. 

 

 

▪ Upload Files/Folders: Click on the "+ New" button on the left side of the page, 

then select either "File upload" or "Folder upload". Navigate through your files, 

select what you want to upload, and click "Open". 

 

▪ Share files/folders: Right-click on the uploaded file/folder and select "Share". 

You can then add the email addresses of people you want to share the file/folder 

with, or you can generate a link that you can send to them. 

 

 

 

  

https://drive.google.com/
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Task Sheet 6.1:  

 

Task Sheet 6.1: Upload Digital Contents 

Title: Upload Digital Contents 

Performance Objective: At the end of this task, the trainee should be able to: 

1. Select an appropriate online media platform for uploading the digital contents. 

2. Complete the necessary formalities for the chosen platform. 

3. Upload the digital contents and ensure they are accessible to users. 

Policy and Documents Required: 

• Digital content upload policies 

• User manuals or guides of the chosen platform 

Tools and Materials Required: 

• Final digital learning content 

• User credentials for the chosen platform 

Equipment: 

• Laptop/Computer with internet access 

Steps/Procedures: 

1. Select an Appropriate Platform: 

• Consider user accessibility, platform reliability, storage capacity, and other relevant 

factors to choose an appropriate online media platform for uploading the digital 

contents. 

2. Complete Necessary Formalities: 

• Sign in or register on the chosen platform using the provided user credentials or follow 

the registration process. 

3. Prepare Digital Contents for Upload: 

• Ensure that the final digital learning content is ready for upload and is in the 

appropriate format as required by the chosen platform. 

4. Upload the Digital Contents: 

• Follow the platform's procedures for uploading digital content. This may involve 

selecting the right file or folder, adding relevant metadata, and providing appropriate 

descriptions. 

5. Check Accessibility: 

• After uploading the digital contents, verify that they are accessible to users. Test 

access from different devices and ensure all media elements, links, and interactive 

components work correctly. 

6. Ensure Compliance with Policies: 

• Review the digital content upload policies to ensure that all requirements and 

guidelines are followed during the upload process. 
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7. Document the Upload Process: 

• Document the details of the upload process, including the chosen platform, upload 

date and time, and any issues encountered and resolved. 

Assessment Method: Assessment of the trainee's ability to select an appropriate platform, 

complete the necessary formalities, and successfully upload and check the digital contents. 

The assessment will evaluate the trainee's understanding of platform selection criteria, ability 

to follow upload procedures, and confirmation that the uploaded contents are accessible to 

users. 
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Specification Sheet 6.1 

A. Policy and documents required: 

▪ Bangladesh National Qualifications Framework (BNQF) 

▪ Competency Standard or “Training Package” 

 

B. Tools and Material required: 

▪ Notebook 

▪ Handbook 

▪ Office Stationeries 

 

C. Equipment: 

▪ Laptop/Computer 
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Review of Competency 

Below is yourself assessment rating for module “Developing Digital Learning Materials” 

SL 

no 
Assessment of performance Criteria  Yes No 

1.  Contents need to be digitized are selected   

2.  Learning resources specifications are established in line with target 

learners’ requirements 
  

3.  Lesson plan is prepared incorporating pedagogy aspect   

4.  Digital contents to be developed are structured and segmented 

according to lesson/ session plan steps and sequences 
  

5.  Types of presentation are planned   

6.  Content development software and content development tools are 

selected and collected 
  

7.  Media elements of the presentation are planned   

8.  Technology, Pedagogy and Content Knowledge (TPACK) 

principles are followed during the plan of content development 
  

9.  Sources of media elements for the presentation are selected and 

collected. 
  

10.  Media elements are downloaded or collected from appropriate 

source. 
  

11.  Media elements are manipulated and edited as required.   

12.  Video is cut and appended as required to use in presentation.   

13.  Open educational resources (OER) are selected and collected   

14.  Media elements are organized and appended with content 

development software as per lesson/ session plan. 
  

15.  Proper action verbs are used and maintained during the preparation 

of the objectives of the session / lesson. 
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16.  Media elements used in digital content are formatted.   

17.  Appropriate animation is used to make the presentation attractive 

and interactive 
  

18.  OER are accessed and used during the content development 

process if required 
  

19.  Test criteria and instruments are developed in line with learning 

material specification. 
  

20.  Test sites and reviewers are identified in line with established 

target users 
  

21.  Testing of learning contents are undertaken in line with plan   

22.  Feedback and suggestions are addressed in line with plan and 

development cycle. 
  

23.  Developed digital contents are preserved in appropriate storage   

24.  Appropriate online media is selected for uploading digital contents   

25.  Digital content uploading formalities are done   

26.  Digital contents are uploaded in online media for users   

 

I now feel ready to undertake my formal competency assessment. 

 

 

 

Signed: 

Date: 
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https://www.semrush.com/blog/content-creation-tools/
https://byjus.com/govt-exams/microsoft-powerpoint/
https://www.teachmeprezi.com/what-is-prezi/
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